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GFL-002
Warnings, Cautions, and Notes

as Used in this Publication

Warning

Warning notices are used in this publication to emphasize that hazardous voltages,
currents, temperatures, or other conditions that could cause personal injury exist in this
equipment or may be associated with its use.

In situations where inattention could cause either personal injury or damage to
equipment, a Warning notice is used.

Caution

Caution notices are used where equipment might be damaged if care is not taken.

Note

Notes merely call attention to information that is especially significant to understanding
and operating the equipment.

This document is based on information available at the time of its publication. While
efforts have been made to be accurate, the information contained herein does not
purport to cover all details or variations in hardware or software, nor to provide for
every possible contingency in connection with installation, operation, or maintenance.
Features may be described herein which are not present in all hardware and software
systems. GE Fanuc Automation assumes no obligation of notice to holders of this
document with respect to changes subsequently made.

GE Fanuc Automation makes no representation or warranty, expressed, implied, or
statutory with respect to, and assumes no responsibility for the accuracy, completeness,
sufficiency, or usefulness of the information contained herein. No warranties of
merchantability or fitness for purpose shall apply.

The following are trademarks of GE Fanuc Automation North America, Inc.

Alarm Master CIMSTAR Helpmate PROMACRO

Series Six CIMPLICITY GEnet Field Control
Logicmaster Series One Series 90 CIMPLICITY 90-ADS
Genius Modelmaster Series Three VuMaster
CIMPLICITY PowerTRAC Genius PowerTRAC ProLoop Series Five
Workmaster

©Copyright 1994 GE Fanuc Automation North America, Inc.
All Rights Reserved
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Preface

Content of this Manual

Chapter 1. Introduction: Chapter 1
describes the Hand-held Monitor. This
chapter lists catalog numbers and
specifications. It also explains
compatibility between different versions
of the Hand-held Monitor and various
other products.

Chapter 2. Hardware Setup: Chapter 2
givesinstructions for powering the HHM,
changing its EPROM, and changing its
battery pack. It also describes how to
install the HHM on a panel, and how to
install a separate HHM connector on a
bus.

Chapter 3. Getting Started: Chapter 3
explains how turn on the Hand-held
Monitor, and how to set up its features for
your application. Chapter 3 also explains
how to test the Hand-held Monitor’s
operation.

Chapter 4. Device Configuration:
Overview: Chapter 4 gives basic
instructions for using the Hand-held
Monitor to configure Genius devices.

Chapter 5. Monitoring the Bus and its
Devices: Chapter 5 explains how to use the
Hand-held Monitor to display data and
status information from other devices on
the bus. It also explains how to clear faults,
switch a dual bus, execute Pulse Testing,
and display the bus scan time.

Chapter 6. Reading CPU Memory:
Chapter 6 explains how to use the HHM
to read the contents of specified memory
locations in CPUs on the bus.

Chapter 7. Error Messages: Chapter 7
defines messages that may be displayed
during HHM startup or operation, or
device configuration.

Related Publications

For more information, refer to these
publications:

Genius I/O System User’s Manual
(GEK-90486-1). Reference manual for
system designers, programmers, and
others involved in integrating Genius I/0
products in a PLC or host computer
environment. This book provides a
system overview, and describes the types
of systems that can be created using
Genius products. Datagrams, Global Data,
and data formats are defined.

Genius Discrete and Analog Blocks User’s
Manual (GEK-90486-2). Reference
manual for system designers, operators,
maintenance personnel, and others using
Genius discrete and analog I/0 blocks.
This book contains a detailed description,
specifications, installation instructions,
and configuration instructions for all
currently-available discrete and analog
blocks.

Series 90-70 Remote I/0O Scanner User’s
Manual (GFK-0579). Reference manual
for the Remote I/0 Scanner, which
interfaces a drop containing Series 90-70
modules to a Genius bus. Any CPU
capable of controlling the bus can be used
as the host. This book describes the
Remote I/0 Scanner features,
configuration, and operation.

Genius Bus Interface Unit and Field
ProcessorUser’s Manual (GFK-0825).
Reference manual for the Bus Interface
Unit and the Field Processor, which
interface a station containing Field
Control modules to a Genius bus. Any
CPU capable of controlling the bus can be
used as the host. This book describes the
features, configuration, and operation or a
Bus Interface Unit or Field Processor.

Field Control I/0 Modules User’s Manual
(GFK-0826). Reference manual for system
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designers, operators, maintenance
personnel, and others using Field Control
170 modules. This book contains a
detailed description, specifications, and
installation instructions for all
currently-available I/O modules.

Series 90™ -70 Bus ControllerUser’s
Manual (GFK-0398). Reference manual
for the Bus Controller, which interfaces a
Genius bus to a Series 90-70 PLC. This
book describes the installation and
operation of the Bus Controller. It also
contains the programming information
needed to interface Genius1/0 devices to
a Series 90-70 PLC.

Series 90™ -30 Bus ControllerUser’s
Manual (GFK-1034). Reference manual
for the Bus Controller, which interfaces a
Genius bus to a Series 90-30 PLC. This
book describes the installation and
operation of the Bus Controller. It also
contains the programming information
needed to interface Genius I1/0 devices to
a Series 90-30 PLC.

SeriesSix™ BusControllerUser’s
Manual (GFK-0171). Reference manual

for the Bus Controller, which interfaces a
Genius bus to a Series Six PLC. This book
describes the installation and operation of
the Bus Controller. It also contains the
programming information needed to
interface Genius I/0 devices to a Series Six
PLC.

SeriesFive™ BusControllerUser’s
Manual (GFK-0248). Reference manual
for the Bus Controller, which interfaces a
Genius bus to a Series Five PLC. This book

Hand-heldMonitor User’s Guide - June 1994

describes the installation and operation of
the Bus Controller. It also contains the
programming information needed to
interface Genius I/0 devices to a Series
Five PLC.

Genius I/0 PCIM User’s Manual
(GFK-0074). Reference manual for the
PCIM, which interfaces a Genius bus to a
suitable host computer. This book
describes the installation and operation of
the PCIM. It also contains the
programming information needed to
interface Genius I/0 devices to a host
computer.

Genius1/O Single-slot PCIM User'’s
Manual (GFK-0881). Reference manual
for the Single-slot PCIM, which interfaces
a Genius bus to a suitable host computer.
This book describes the installation and
operation of the PCIM. It also contains the
programming information needed to
interface Genius I/0O devices to a host
computer.

We Welcome Your Comments
and Suggestions

At GE Fanuc automation, we strive to
produce quality technical documentation.
After you have used this manual, please
take a few moments to complete and
return the Reader’s Comment Card
located on the next page.

Jeanne L. Grimsby

Senior Technical Writer

GFK-0121E
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Chapter Introduction

1

The Hand-held Monitor (HHM) is a convenient operator
interface device that can be used to set up and monitor a Genius
I/0 and communications system.

The HHM features:
®  An LCD display with four lines of 16 characters each.

GENIUS mon
Hand Held Monltor @ oty
GE Fanuc

)

m Selectable display language: English, German, French, or
Italian.

m A 20-key sealed-membrane keypad.

®m  Akeyswitch that can be used to restrict operator access to
certain functions, as selected for the application.

®m  Operation from its battery pack, or by 115 volt AC
or 230 volt AC power. @
The Hand-held Monitor screen is the operator’s N

window to the Genius bus and all of its devices. It can
be used to display:

DonE
DoDE=
paons
DopE
BOne

o I/0 data for any device on the bus.

Diagnostics.

Bus scan time.

Descriptions of all devices on the bus.
Global Data addresses.

=

O o O O

O Memory data from CPUs on the bus.

The Hand-held Monitor can also be used for device configuration, fault clearing, and forcing 1/0 circuits
and dual bus selection. It can also be set up to prevent the use of any of these capabilities.

A key feature of the Hand-held Monitor is its ability to communicate with I/O blocks and to force discrete
and analogl/O, whether or not there is a PLC or computer connected to the bus. This greatly simplifies
system check-out prior to full-scale system operation.

GFK-0121E 1-1



Hand-held Monitor Description

1-2

HHM Cable —

The HHM Keypad

The Hand-held Monitor keypad has three types of keys: function keys (F1 - F4), decimal
keys, and operation keys.

—— Mode Select Keyswitch

GENIUS  r=”

cfg

GE Fanuc

I

LCD Display

)b

8RRk
- Off

Function Keys

E] E] @ @«&—— Decimal Keys

Operation Keys

Connection for
=<

Charger/Adapter

FunctionKeys: The four keys in the top row (F1, F2, F3, and F4) have functions that
change as the display changes.

F1

F2 F3

F4

The bottom line of the screen shows the current functions of these keys. For example:

nxt

prv actv

bus

Decimal Keys: The decimal keys are used to enter numbers and change sign.

Operation Keys: The four keys on the right side of the keypad are used to control HHM
operations:

Home

Menu

displays the Home menu. Clear
. . On
displays the previous screen. Off

Hand-held Monitor User’s Guide - June 1994

clears HHM error messages,
clears Genius faults,
deletes HHM keypad entries.

turns the HHM on or off.

GFK-0121E
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The HHM Display

The Hand-held Monitor has a 4-line LCD screen. On a new Hand-held Monitor,
displays are in English. The display language can easily be changed to French, German,
or Italian. (Instructions for changing the display language are on page 3-5).

In addition to alphanumeric characters, the display uses the following special characters:

tri-stateinput.

Output with Feedback, or block with both inputs and outputs.
circuit is forced OFE.

circuit is forced ON.

relay block point is forced open.

relay block point s forced closed.

circuit controls a Bus Switching Module.

v IOk Q5

reference address or Device Number not yet assigned.

*

reference address is out of range for the presently-selected HHM host.

For a list of other HHM abbreviations and their meanings, select F3 (HELP) from the
HHM Utilities menu.

Keyswitch
The Hand-held Monitor’s keyswitch can be used to restrict access to certain features of
the HHM.

With the key present, the switch can be placed in either “configure” (cfg) or “monitor”
(mon) position.

cfg with the switch in Configure position, all HHM functions are available. In this
mode, the Hand-held Monitor can be configured to determine which of its fea-
tures will be usable once the key is removed.

mon: with the keyswitch in Monitor position, the HHM can monitor bus and block
data. Additional HHM functions, such as clearing faults or configuring I/O
blocks, can be used in Monitor mode only if the HHM has been set up to permit
their use.

The key must be present to move the switch from Monitor to Configure mode position;
it can only be removed in MON position. Two identical keys are supplied with each
Hand-held Monitor. The key should be removed if system security is a concern.

Accessories

The Hand-held Monitor comes with:

®m A sturdy removable leather case. The case has a rear tab with snap closure for
carrying the HHM on a belt. The handle can be pivoted back to stand the
Hand-held Monitor upright on a table.

®  Arechargeable battery pack.
®m A battery charger/adapter with 8-ft cord.
®  Two keys for the mode-selection keyswitch.

m  Aremovable 5 ft (1.5 meter) coiled communications cable.

Chapter 1 Introduction 1-3



HHM Compatibility

The following table shows which Hand-held Monitor versions are compatible with
specificGenius1/O, Field Control, and related products.

Note that the functionality of an older Hand-held Monitor can be upgraded by replacing
its firmware PROM. (PROM installation instructions are in chapter 2).

Product Product Requires this Hand-
Type Catalog held Monitor Ver-
Number sion (or later)

24/48VD@nalog 4 Input/2 Outputblock IC660BBA020 any
24/48VDRTD 6 Input block IC660BBA021 IC660HHM501B(v2.0)
24/48VD(Thermocouple 6 Input block IC660BBA023 IC660HHM501D(v3.5)
24/48VD(Current-Source Analog4 Input/2Outputblock 1C660BBA024 IC660HHM501E(v3.7)
24/48VDCurrent-Source Analog 6 Output block IC660BBA025 IC660HHM501G(v4.0)
115VAC Analog4Input/2 Outputblock IC660BBA100 any
115VAC/125VDRTD 6 Input block IC660BBA101 IC660HHMS501B(v2.0)
115VAC/125VDCThermocouple 6 Input block IC660BBA103 IC660HHMS501D(v3.5)
115VAC/125VDCurrent-Source Analog 4 Input/2 Outputblock IC660BBA104 IC660HHMS501E(v3.7)
115VAC/125VD urrent-Source Analog 6 Output block IC660BBA105 IC660HHM501G(v4.0)
24/48VDCSource161/Oblock 1C660BBD020 any
24/48VDCSink161/0block IC660BBD021 any
24VDCSource 161/0Oblock 1C660BBD022 any
24VDCSink 161/0block IC660BBD023 any
12/24VDCSource321/0Oblock IC660BBD024 IC660HHM501B(v2.0)
5/12/24VDCSink32l/Oblock 1C660BBD025 IC660HHMS501B(v2.0)
115VAC81/0block IC660BBD100 any
115VAC81/0 Low Leakage block IC660BBD101 an
115VAC 16 Input block IC660BBD110 IC660HHM501B(v2.0)
115VAC/10-30VDCHigh-SpeedCounterblock,v1.x IC660BBD120 IC660HHM501D(v3.5)
115VAC/10-30VDCHigh-Speed Counterblock,v2.0 IC660BBD120D | IC660HHM501G(v4.0)
115/230¥AC Relay Normally-closed 16 Output block IC660BBR100 IC660HHM501B(v2.0)
115/230¥AC Relay Normally-open 16 Output block IC660BBR101 IC660HHMS501B(v2.0)
115VAC/125VDC81/Olsolated Block with Failed Switch Diagnostic IC660BBS100 any
115VAC/125VDC8I/OlsolatedwithoutFailed Switch Diagnostic 1C660BBS101 any
115-230VAC/125VD@PowerTRAC block, v.2.2 or earlier IC660BPM100 IC660HHMS501D(v3.5)
115-230VAC/125VD(PowerTRAC block, v.2.3 IC660BPM100C | IC660HHM501G(v4.0)
Series Five Genius Bus Controller IC655BEM510 IC660HHM501C(v3.0)
Series 90-70 Genius Bus Controller IC697BEM731 IC660HHMS501F(v3.8)
Series Six Genius Bus Controller with Diagnostics 1C660CBB902 any
Series Six Genius Bus Controller without Diagnostics IC660CBB903 any
Series 90-30 GENIUS Communications Module 1C693CMM301 IC660HHM501C(v3.0)
GENIUS Network Interface (GENI) module 1IC660ELB905 any
IBM PC Interface Module (PCIM) IC660ELB906 any
GENIUS Network Interface (GENI) module with inverted connector IC660ELB910 any
Series90-70 Remotel/O Scanner IC697BEM733 IC660HHM501G(v4.0)
24/48VDCBusSwitchingModule (BSM) IC660BSM021 any
115VAC/125VDCBusSwitchingModule (BSM) IC660BSM115
Field Control products (all) IC670xxxXXX IC660HHM501]J(v4.6)

14
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HHM Specifications

Operatingtemperature 0-60 C(32-140 F)
Storagetemperature -40 to +70 C(-40 to 158 F)
Humidity 5-95% (non-condensing)
Weight: withoutcase 1.31bs (0.6 Kg)

with case 1.81bs (0.8 Kg)
Size (HxWxD): withoutcase 8.00”x”3.75x” 1.25 (cmx)

with case 10.857x4.30”x2.25”

Required AC power (for battery charger)

Fully chargedoperation

115/230WAC 15%, 47-63 Hz

(16-hourcharging period for [C660BPM500B.
8-hourcharging period forIC660BPM500A, now
discontinued.)

6 hours

Displaycharacters 4 lines each of 16 LCD (0.2” - 5 mm high)

Keyboard 20 sealed keys with tactile feedback

Features Performs GeniusI/Oblock configuration, monitors
I/0dataon Geniusbus, displays diagnosticin-
formation.

Displaylanguage English, German, French, or Italian

Drop Test Survives drop from 4 feet (1.2 meters) to concrete
floor landing on any surface or corner without af-
fectingitsoperation.

DataRates 153.6 Kbaud standard, 153.5 Kbaud extended, 76.8

Kbaud, 38.4 Kbaud

Ordering Information

GFK-0121E

Description Catalog Number
Hand-HeldMonitor (includes all items listed below) IC660HHMA501
CablefromHHM tol/OBlock IC660HHC005
Battery Pack IC660BPM500
Battery Charger IC660BCM501

Optional Accessories

External HHM Connector: A panel-mountable or DIN rail-mountable HHM connector
(catalog number 44A736310-001-R001) is available. It can be used to provide a
permanent HHM connection point on a Genius bus. See chapter 2 for a description.

230VAC Power Adapter: An optional 230VAC Power Adapter (IC660MCA512) can be
used to connect the Hand-held Monitor Charger to variety of 230 VAC power outlets by
means of a standard computer cable (not supplied). See chapter 2 for a description.

Extra HHM Keys: For applications requiring extra keys for the Hand-held Monitor, a
group of five sets can be ordered separately. The catalog number is IC660MKS511.

Chapter 1 Introduction 1-5



Chapter

2

Hardware Setup

Power for the Hand-held Monitor

GFK-0121E

The Hand-held Monitor can be operated using its built-in battery, or connected to either
115 volt or 230 volt AC power. A battery pack must always be installed to operate the HHM,
even when using AC power.

An optional 230VAC Power Adapter can be used to connect the Hand-held Monitor Charger
to variety of 230 VAC power outlets. See page 2-2 for more information.

Charging the Battery Pack for AC Operation

To operate the HHM using AC power, if the battery pack is new or has become fully
discharged by operating the HHM on battery power, it must be charged for at least 20
minutes. If it is necessary to restore temporary operation before charging is complete:

m Plug the adapter cable into the HHM.

® Wait 15 seconds and power up the HHM. It may be necessary to remove the battery pack
for 15 seconds, then reinstall it.

Note that continually using the Hand-held Monitor in AC mode for an extended period of
time causes the battery pack to deteriorate. After up to two years of AC operation of the
HHM, the battery pack may not be able to accept enough charge to operate the HHM
independently. However, it can still be used for AC operation.

Selecting 120 VAC or 230 VAC

Before plugging the adapter into AC power to operate or charge the Hand-held Monitor,
be sure the switch at the base of the adapter is correctly set to match the incoming
power (120 volts AC or 230 volts AC).

120V

position \

230V
position

The Hand-held Monitor will operate while the adapter is connected.
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Using the 230VAC Power Adapter

The optional 230VAC Power Adapter (IC660MCA512) can be used to connect the Hand-
held Monitor Charger to variety of 230 VAC power outlets by means of a standard com-
puter cable (not supplied).

The Adapter has a receptacle on the top for the Hand-held Monitor Charger and an IEC
320 receptacle on the side for the computer cable.

HHM Charger receptacle in
top of Adapter

IEC 320 receptacle in
side of Adapter

Instructions

1. Set the power selection switch on the Hand-held Monitor Charger to the 230V position.

A
v

position OJ

2. Plug the Hand-held Monitor Charger into the top receptacle on the Power Adapter
unit.

3. Plug the computer cable into the IEC receptacle on side of the Power Adapter unit.

4. Connect the computer cable to a suitable 230VAC power source.

During normal operation, it is best to connect and disconnect the cable at the outlet, not
at the Adapter.

Hand-held Monitor User’s Guide — June 1994 GFK-0121E
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Battery Operation

The HHM'’s battery pack provides up to 6 hours of operation. To maximize battery life,
allow the battery to discharge fully between charges. The battery should be allowed to
fully discharge once a month.

Low Battery Power

Low battery power may cause this message:

** LOW BATTERY * *
**HHM HALTED * *
Please Recharge

Or the display may blank, or two black lines may appear briefly. Low battery power
suspends the current operation.

Charging the Battery Pack

When you receive a new Hand-held Monitor, its battery pack is not charged. Before
using a new battery pack to power the HHM for the first time, charge it by plugging the
adapter into a power source for 24 hours. After this initial charging, subsequent
rechanges will require only 16 hours.

Maintaining spare battery packs will allow the HHM to operate using one battery pack
while another is being charged.

If the battery pack won't take a charge, it usually indicates a faulty battery pack, not a
faulty Hand-held Monitor. Try another battery pack. Replacement (uncharged) battery
packs are available.

If a battery pack is left uncharged for a long time, it may be necessary to remove the
battery pack from the HHM and charge it while removed for up to 15 minutes.

Replacing the Battery Pack

To replace the battery pack, use a Phillips screwdriver (size 0 or 1) to release the retaining
screw at the bottom of the HHM. Slide the battery pack out, insert another, and tighten
the screw.

Automatic Shutoff

To conserve power, the Hand-held Monitor automatically shuts off 10 minutes after the
last key is pressed. For applications where continual operation is preferred, the
automatic shutoff feature can be disabled. See page 3-5 for more information.

Chapter 2 Hardware Setup 2-3



Changing the PROM

2-4

New features can be added to upgrade a Hand-held Monitor by replacing its PROM as

described below.

To prevent possible damage to the Hand-held Monitor, this operation should be
performed in an area equipped with suitable electrostatic discharge protection.

1. Ifthe HHM is connected to AC power, disconnect it.

Caution

2. Remove the HHM battery pack as described on the previous page.

3. On the front of the Hand-held Monitor, remove the two Phillips-head screws located
near the 7 and HOME keys.

4. Gently raise the keyboard up from the bottom to release the lip between the

keyboard and the display.

5. Once this lip is free, open the keyboard to the right, as illustrated below. It is not

necessary to remave the ribbon connector.

Install PROM
with notch to
right as shown

GENIUS

Hand Held Monltor

GE Fanuc

mon

@ o

~

~

I

L

[0,
/

O

OGCoo ¢

OO0
OO00O
O0O00O

6. Remove the old PROM. If you don’t have a PROM extraction tool, a small screwdriv-
er can be used instead, carefully working from side to side.

Hand-held Monitor User’s Guide — June 1994
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7. If necessary, bend the pins on the PROM so they line up properly with the holes in
the socket. Bend the pins by pressing each side against a clean desk or table top as
shown below. If possible, a conductive mat should be used.

mmgmmﬁ

46024

e

Conductive mat

8. Insert the EPROM or Battery-Backed RAM into the socket.

IMPORTANT: Inserting the PROM backward can damage the Micro PLC and
destroy the PROM.

Newer PROMs may be physically longer, but all PROMs must be inserted flush with
the left edge of the socket, with the notch toward the ribbon connector.

9. Reposition the keyboard in its lip and tighten the two screws.

10. Reinstall the battery pack.

Chapter 2 Hardware Setup 2-5



Permanent Installation

2-6

If the Hand-held Monitor is to be installed using the metal bracket provided, follow the
instructions below. Do not install the HHM yet if it will be used to configure I/O blacks.

The mounting bracket provided can be used to install the Hand-held Monitor behind a
panel. You will need to make a cutout in the panel for the HHM (see next page).

You will also need to install a connector for the Hand-held Monitor within reach of the
HHM'’s cable. The extra D-shell connector provided with the Hand-held Monitor
requires a panel cutout, with the bus cable and Hand-held Monitor located on the
opposite sides of the panel (see page 2-8).

An optional panel-mountable or DIN rail-mountable connector is also available. It does
not require a cutout. See page 2-9 for details.

Back of HHM ] Behind Panel

¢

Bracket Optional HHM

Connector

¢
1

To Power Source

Bus In
Bus Out

Configuring a Permanently-installed HHM

Ordinarily, a Hand-held Monitor installed on a panel serves as an operator station. Its
configuration may be different from that of a portable HHM.

m Jts Device Number must be changed from 0 to some other number.
®  Automatic shutoff may be disabled.
®m [/0 block configuration and other features may also be disabled.

After the HHM is configured, its keyswitch should be placed in MON position, and the
key removed.

Hand-held Monitor User’s Guide — June 1994 GFK-0121E
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HHM Installation Instructions

1. Select a suitable location for the HHM. Environmental specifications are listed on
page 1-5. The location must have 115 VAC or 230 VAC power.

2. Cut an opening 3.75" (9.53cm) wide x 8” (20.32cm) high in the panel. Drill four
mounting holes as shown below.

4.38in
(11.13Icm) —»
3.75in
ﬁ (9.53cm) *‘ *
— ( | _LT 1.00in (2.54cm)
<&

|
| ¢ A
| |
I Cutout |
|
I | 6.00in
| | (15.24cm)
| |
|
| |
E oY
L i .
- L J— 1.00in (2.54cm)

A

3. Attach the bracket to the HHM with the screws, washers, and lockwashers provided.

/ .
\ @‘
910
(4) holes for
mounting on
panel
9
o
|/
O (2) holes for mounting to
— back of Hand-held Monitor

4. Using appropriate hardware (not provided), mount the HHM and bracket in the
cutout.

5. Connect the power cord to the HHM, and connect the signal cable to the connector.

Chapter 2 Hardware Setup
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Installing the D-Shell HHM Connector

Follow the instructions below if you are installing the supplied D-shell connector on the
bus.

1. Using the mounting plate as a template, cut an opening in the panel for the mating
connector. Also drill two holes for the mounting hardware.

2. Attach the mounting plate and mating connector to the panel using the mounting
hardware supplied.

3. Secure the two ends* of the serial bus cable to the back of the panel using strain
relief brackets.

4. Strip the ends of the wires. Twist the two Serial 1 wires together and attach them to
pin 5 of the connector. Twist the Serial 2 wires together and attach them to pin 9.
Similarly; attach the Shield wire(s)* to pin 4.

The following illustration shows connections for incoming and outgoing serial bus
cable. As with other devices, the HHM connector may be at either end of its bus. If it
is, there will only be one bus cable attached.

Bus Strain Bus

Cable  Reliefs Cable Mounting
Hardware

a42240c

Hand-held
Mating Mounting Monitor
Connector Plate Connector
1 7\

\
¢---20

lofofg

0

!

6---=0

Mounting Surface
(rear view)

When making bus connections, the maximum exposed length of bare wires should
be two inches. For added protection, each shield drain wire should be insulated with
spaghetti tubing to prevent the Shield In and Shield Out wires from touching each
other.

If the HHM connector is at either end of its bus, it is necessary to install an
appropriate terminating resistor across the Serial 1 and Serial 2 wires. The Genius /O
System and Communications User’s Manual lists appropriate terminating resistors for
each recommended bus cable type.
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Installing a Separate Hand-held Monitor Connector

You can add a connector to the bus for a permanently-mounted Hand-held Monitor, or
to provide an additional attachment point for a portable HHM.

The unit shown below (catalog number 44A736310-001-R001) provides a Hand-held
Monitor connector and serial bus terminals.

5 in - 1673in aoss7
1.27 cm 4.249cm
A
Ve - Hand-held Monitor
// Connector
N
O
(‘5\//
N
\
N\

Panel Mounting Ear

2.834 in
7.198 cm F\\

AN
TN
LI Q /\U
X1 X2| SA SB N,
N~ —/
/ . .
D D l/ Serial Bus Terminals
X1 x2|sa s8| < | = X1  Serial 1
' X2  Serial 2
SA  Shield In
shown at 100% of actual size SB  Shield Out

Mounting the HHM Connector

This unit can be easily mounted on a rail such as a standard 35mm (shown below) or

15mm DIN rail. The panel-mounting ears are not used if the unit is installed on a DIN
rail.

DH: 46358

T 35mm DIN rail

I

— |

)
L
T %‘\ (Removable) DIN rail

Mounting Feet

side view: shown at 50% of actual size

Alternatively, it can be installed directly on a panel using screws through its mounting
ears. The DIN rail feet on the back of the unit are removed when the unit is
panel-mounted.
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Making the Bus Connections

The HHM connector has two sets of terminals; one for incoming cable and the other for
outgoing cable.

Connect the Serial 1, Serial 2, and Shield In terminal of either connector to the previous
device. Connect the Serial 1, Serial 2, and Shield Out terminal of the other connector to
the next device.

When making bus connections, the maximum exposed length of bare wires should be
two inches. For added protection, each shield drain wire should be insulated with
spaghetti tubing to prevent the Shield In and Shield Out wires from touching each other.

The following illustration shows connections for incoming and outgoing serial bus cable.
As with other devices, the HHM connector may be at either end of its bus. If it is, there
will only be one bus cable attached.

46366

Bus In

Bus Out

QDD
* L=
Dol B

SA  Shield In
SB  Shield Out

Aswith other devices, if the HHM Connector is at either end of its bus, install an
appropriate terminating resistor across the Serial 1 and Serial 2 terminals. The Genius I/O
System and Communications User’s Manual lists appropriate terminating resistors for each
recommended bus cable type.
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Chapter Getting Started

3

This chapter explains how to:
® Turn on the Hand-Held Monitor
o0 Set the HHM Baud Rate
o Display the Home Menu
®  Change the Hand-held Monitor’s configuration:
the HHM Device Number
the HHM Display Language
the Host CPU
automatic shutoff
ability to Change Block ID Parameters
ability to Change the Baud Rate of Devices on the Bus
ability to Configure Devices on the Bus
ability to Forcel/OCircuits

O 0O 0O o o o o o o

ability to Clear Faults

®m  Test the operation of the Hand-held Monitor.
o the Keypad
o the Display Screen
o the Internal Electronics

®  Display an alphabetical list of definitions for the definitions used on the HHM screen.

GFK-0121E

31



Turning on the Hand-Held Monitor

With the battery pack charged, or with the HHM
connected to a suitable AC power source, press the
ON/Offkey to turn the Hand-held Monitor on.

Caution

Do not connect or disconnect the
HHM to/from another device or con-
nector while it is ON.

Connecting or disconnecting the
HHM while it is ON may disrupt
communications on the bus.

Each time you turn on the Hand-held Monitor, it
executes a brief self-test.

GENIUS HHM
COPR. (date)
GE Fanuc N.A.

SELFTEST WORKING

(version)

Setting the HHM Baud Rate

Before the HHM completes the self-test, this
screen appears:

HHM BAUD RATE

ACTIVE=153.6K ST

MUST MATCH BUS
chng ok

It shows the baud rate that is currently set up for
the Hand-held Monitor. The baud rate must be the
same for all devices on a bus.

3-2
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1. If the baud rates match, press F4 (Ok).

If the baud rates do not match, press F2
(Change) instead. The HHM screen changes to
allow you to select a different baud rate:

HHM BAUD RATE

ACTIVE-= (baudate)

PROG = (baudate)
tgl entr ok

A. With the key in CFG position, press F2
(Toggle). The selection changes to 76.8K,
38.4K, 153.6K extended, and back to 153.6K
standard.

B. When the correct baud rate appears on line
3, press F3 (Enter). Press F4 (Ok) to return
to the first baud rate screen.

2. Press F4 (Ok) to display the Home menu.

Powerup Error Messages

Chapter 7 lists error messages that may appear at
powerup.

Sometimes, an error message appears although
the HHM has powered up normally.

POWERUP ERROR #4 or #5 may be caused by
excessive noise on the bus, or by an attempt to use
different baud rates on the same bus.

GFK-0121E



Displaying the Home Menu

This is the Hand-held Monitor’s Home menu:

HHM

UTILITTIES

ANALVYZE

CONFIGURATION

DEVICE MEMORY

B. Pressing the Home key or DMenu key from a
lower-level screen.

Use the Home menu to get to any other HHM

Display the Home menu by either:
A. Pressing F4 (Ok) from the first baud rate

screen, or

with the HHM.

function, as shown below.

Notice that different screens appear, depending on
the type of device that is currently communicating

The Main HHM Screens

F1: HHM UTILITIES
F2: ANALYZE

F3: CONFIGURATION
F4: DEVICE MEMORY

GFK-0121E

See page 5-17 for
instructions.

F1 F2 F3
F1: HHM CONFIG F1: MONITOR BLOCK F1: PROG BLOCK ID
F2:SELF-TEST F2: MNTR/CTRL REF F2: CONFIGBLOCK |_|__|_|
F3: HELP F3: BLOCK/BUS STS F3: COPY CONFIG
F4: PULSE TEST
F1 F1 F1
HHM CONFIG REFS o PROG BLOCK ID
| | BLOCKNO. 0 | | 34567890 | | wo
0000000 BLOCK NO.
chng nxt A1000111 ref blk nxt
See page 3-4 for See page 5-4 for See page 4-4 for
instructions. instructions. instructions.
F2 F2 F2
F1: KEYPAD TEST MNTR/CNTL O s
| | F2:DISPLAY TEST | | sTATE: © || Ungxﬁ“ﬁiﬁiﬁgzre
F3: TEST INTRNALS NO FAULTS 9
F4: > on off reles screens)
See page 3-7 for See page 5-9 for See Geniusl/O
instructions. instructions. Blocks Manual or
individualblock
F3 F3 manual for
instructions.
REFS o) Fa
L (helpscreens) L DC16K 15 v2.0ACT
FORCED, NO FAULTS COPY CONFIG
nxt prv actv bus FROM : TO
.See page vl fOI‘ chng entr
instructions.
Fa See page 4-6 for
instructions.
PULSE TEST
REFS 0
~ | NOFAULTS
exec
For Most

Genius Devices

F2

F1: MONITOR
F2: CONFIGURATION

F1

F1 Monitor I/O
F2:Faults

F3 Previous Menu

See page 5-15 for
instructions.

F2

F1: GENIUS CONFIG
F2: Module Config

F3: Previous Menu

See page 4-7 for
instructions.

For Field
Control

F4

DEVICE MEMORY #
(reference)

tgl chng entr SBA

Chapter 3 Getting Started

See chapter 6 for
instructions.
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Configuring the Hand-held Monitor

You can change the following operating
characteristics of the Hand-held Monitor:

m PLC reference format.

153.6 Kbaud “standard” baud rate.
Device Number set to 0.

English language displays.

Shutdown after 10 minutes of inactivity.

I/Oblock configuration enabled.

I/Ocircuitforcing enabled.

m Fault clearing enabled.

Select F1 (HHM Utilities) from the Home menu to
access the HHM Utilities menu:

F1:HHM CONFIG
F2:HHM SELF TEST
F3:HELP

F 4

To change the configuration of the Hand-held
Monitor, select F1 (HHM Config) from the HHM
Utilities menu.

Note
The HHM key must be in the key-
switch, turned to CFG position.

After setting up the configuration, you can prevent
changes by turning the keyswitch to the MON
position and removing the key.

3-4
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Changing the HHM Device Number

The Device Number (serial bus address) assigned
to the Hand-held Monitor appears on line 2 of the
first HHM configuration screen.

HHM CONFIG
BLOCK NO. (0]

chng nxt

Each device on a Genius bus must have a unique
serial bus address number. A new HHM has
number 0. If multiple HHMs will be used on the
same bus, each of them must be assigned a
different Device Number.

If you want to change the HHM Device Number,
follow these steps:

m Press the ON key. Go to the Home menu. Se-
lect F1 (HHM Utilities), then F1 (HHM Config).

® From the HHM Configure menu, press F2
(Change) to clear the existing Device Number.
Enter the new number and press F3 (Enter).

Pressing F4 from the buad rate screen will advance
you through additional HHM configuration
screens. Press Home if you want to return to the
Home menu, or use the DMenu key to go back to
the previous screen.

GFK-0121E
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Changing the HHM Display Language

The next display shows the current language
selection.

HHM CONFIG
LANGUAGE
ENGLISH
tgl entr nxt

Press F2 (TGL) to change the display language
(French, German, Italian, English). Press F3
(Enter) to save the change.

Selecting the Host CPU

The next display shows the Hand-held Monitor’s
host CPU selection. The choices are: Series Six,
Series Five, PCIM/QBIM/GENI, orSeries90.

SELECT HOST CPU
SERIES SIX

To change the host CPU type, press the F2 (TGL)
key, then press F3 (Enter).

Chapter 3 Getting Started

Enabling/Disabling Automatic Shutoff

The next screen shows whether automatic shutoff
is selected.

AUTO OFF = 10Omin

ENABLED

This feature conserves battery power by shutting
off the Hand-held Monitor 10 minutes after the
last key press. To change the current selection,
press F2 (Toggle), then F3 (Enter).

Enabling/Disabling the Ability to Change Block
ID Parameters

The next display shows whether the Hand-held
Monitor is able to configure the Block Number
(serial bus address) of bus devices, as well as the
/0 circuit mix of some types of I/O blocks.

CHNG BLK 1ID
ENABLED

This selection also determines whether the HHM
is able to assign the Reference Addressof1/O
blocks, or change the I/0O mapping of a Remote
[/0 Scanner (for the modules in its remote drop).

To enable or disable this capability, press F2 (TLG),
then F3 (Enter).
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Enabling/Disabling the Ability to Change the
Baud Rate of Devices on the Bus
The next configuration screen shows whether the

HHM is able to change the baud rate of bus
devices.

CHNG BLK
ENABLED

BAUD

To change the current selection, press F2 (Toggle),
then press F3 (Enter).

Enabling/Disabling the Ability to Configure
Devices on the Bus
The next display shows whether the HHM is able

to change the other configurable features of bus
devices.

CHNG BLK
ENABLED

CONFIG

Enabling/Disabling the Ability to Force I/0
Circuits

The next display shows whether the HHM can be
used to force I/ 0O circuits.

CIRCUIT FORCING

ENABLED

To change the current selection, press F2 (Toggle),
then press F3 (enter).
Enabling/Disabling the Ability to Clear Faults

The next display shows whether the HHM can
clear faults on bus devices.

CLEAR BLK
ENABLED

FAULTS

To change the current selection, press F2 (Toggle)
then press F3 (Enter).
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Testing Operation of the Hand-held Monitor

If you want to test the Hand-held Monitor display,
keypad, or internal electronics, select F2 (HHM
SELF-TEST) from the HHM Utilities menu. This
menu of tests appears:

F1:KEYPAD TEST
F2:DISPLAY TEST
F3:TEST INTRNALS
F4:

Testing the Keypad
Press F1 (KEYPAD TEST). The HHM prompts:

KEYPAD TEST
STRIKE ANY KEY
KEY=

MON/CFG KEY=CFG

®m Press any key you want to test. Each key press
is shown on the display. The HOME, D
MENU, and ON/OFF keys are tested by their
operation.

m  To test keyswitch operation, turn the key and
observe the bottom line of the display.

m Press D MENU to perform another test, or
press HOME to return to the Home menu.

Testing the Display Screen

Press F2 (DISPLAY TEST) from the HHM Utilities
menu. The screen first displays uppercase letters
and special characters:

DISPLAY TEST
ABCDEFGHIJKLMNOP
QRSTUVWZYZO12345
6789 :>2—./1001

Next, a screen of lowercase letters appears,
followed by a continuous test pattern, which
checks pixel operation. When the test pattern is
finished, press DMENU to perform another HHM
test, or press HOME to return to the Home menu.

Chapter 3 Getting Started

Testing the Internal Electronics

Press F3 (TEST INTRNALS) from the Self-Test
menu. After a moment, the HHM displays:

TEST INTRNALS

SELFTEST
exec

WORKING

If an error occurs, one of the following messages
will appear instead.

PROCESSOR FAIL
RAM FAILURE
EPROM FAILURE
EEPROM FAILURE
COMM ERROR

H &6 HEH

Press the Clear key and try the test again. If the
message returns, replace the HHM. Otherwise,
continue.

An EEPROM failure will not prevent use of the
Hand-held Monitor. However, the HHM will not be
able to retain changes to its default configuration
through a power cycle.

The COMM ERROR message may indicate that
the Hand-held Monitor is not attached to a
correctly-terminated bus.
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Chapter |  Device Configuration Overview

4

The Hand-held Monitor can be used to configure (establish the operating characteristics for) a wide
variety of other devices. Some configurable devices are:

®m  Genius I/0 Blocks, High-speed Counter Blocks, and PowerTRAC Blocks
m the Series 90-70 Remote [/0 Scanner and its remote drop
m Field Control stations.

The Hand-held Monitor displays a unique set of configuration screens for each type of configurable
device.

Because of the wide assortment of configuration features provided by the HHM, it has not been possible
to include them all here. You should refer to the more detailed configuration instructions in the User’s
Manual for the type of device you are configuring.

GFK-0121E
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Online or Offline Configuration

Devices can be configured before or after
installation on a properly-terminated serial bus. If
a new device is to be added to an existing bus
running at a baud rate other than 153.6 Kbaud
standard, the device must first be configured
offline. Be careful adding new devices to existing
systems. Be sure the baud rate configured for the
new device matches that of the system - never mix
baud rates on a bus.

Online Configuration

When configuring a device on an operating bus,
the Hand-held Monitor must be the ONLY HHM
plugged into a device on the bus. If devices are
configured online, the HHM automatically check
for PLC reference address conflicts.

Offline Configuration

It may be most convenient to configure devices
off-line at a central location. Each device will need
to be connected to an appropriate source of power
and to earth ground. To prepare a device for
off-line configuration:

1. Connect a 75 ohm resistor across the Serial 1
and Serial 2 terminals, or use the 75 ohm
terminator plug (IC660BLM508).

2. Attach a grounding strap to the device’s
ground screw. Be sure that the strap is
connected to earth ground.

a42468

/ﬁ .
Attach .
Ground i| 2

3
Strap =

H
Terminator

Plug

\s@s&@@s@s@@@@@\@s@@&ss@s@s@&@\‘

4

%

3. Wire the device to the power source and apply
power.

4-2

Warnings

If the device is not properly grounded,
hazardous voltages may exist. Death or
injury may result.

DO NOT TOUCH the connectors or
wiring after powering up the device.
Hazardous voltages exist, and death or
injury may result.

Starting Configuration

Note: To assign a serial bus address, the
Hand-held Monitor must be directly attached to
the device being configured. Additional features
can be configured with the Hand-held Monitor
connected at any point on the bus. In that case, the
device being configured must be selected as the
active device (on the Block/Bus Status screen).

1. Begin with the Hand-held Monitor turned off.
Attach the HHM to the device (see below) or
to another bus connection point.

% PP 242307
0]

®
]

LO000o
I I
CO000
CO000
L0000

dtclotollololotidbidiololidiolololt

Nno J

2. Turn the Hand-held Monitor on. After the
HHM completes its powerup sequence, the
Home menu appears. The Hand-held
Monitor’s Change Block Configuration option
must be enabled to complete the instructions
in this section. For a new device, the HHM’s
Change Block ID and Change Block Baud
options must also be enabled.
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Displaying the Configuration Menus

The illustration below shows how to reach the
HHM'’s device configuration menus from the Main
Menu.

m  For all devices, you will need to select F3 (Con-
figuration) then F1 (Program Block ID) to con-
figure a block’s required features.

O Device Number (serial bus address).

[}

I/Otypeforinput/outputblocks.
o CPU references.
O Baud rate.

For new blocks, this must be done first.

the Configure Block screens to configure re-
dundancy and Configuration Protection.

For a Field Control device, select either F2
(Analyze) or F3 (Configuration) from the Main
Menu. The HHM will then display a special set
of screens for Field Control. (The currently-ac-
tive device must be the Field Control device for
these screens to appear. See page 4-7 if you
need instructions to select the active device).

If the message E: CONFIG PROTECT appears,
you can remove Configuration Protection by:

1. Going through the configuration screens to

reach the Configuration Protection screen.

m  To configure Genius blocks, select F3 (Configu-
ration) from the Main Menu, then F2 (Config- 2. Pressing F2 (Toggle) to select either DISABLED
ure Block) to view and modify other features. orENABLED.
Detailed configuration instructions for each 3. Pressing F3 (Enter) to save the selection.
type of device are provided in its User’s Manual. . .
) ) 4. Pressing F4 (Next) to go to the first configura-
You can use F3 (Copy Configuration) to copy a tion display, D MENU to return to the Configu-
configuration from one block on the same bus .
ration menu, or HOME to return to the Home
to another.
menu.
® To configure a remote drop, continue from the
Program Block ID screens to enter the remote
map (I/0 References) and Drop ID. Then go to
. . F1:HHM UTILITIES
Displaying the HHM F2:ANALYZE
Configuration Menus F3:CONFIGURATION
F4:DEVICE MEMORY
F3 F2 or F3
1
F1:PROG BLOCK ID Fl:Monitor
F2:CONFIG BLOCK F2:Configuration
F3:COPY CONFIG
F4:
F1 F2 F3
All Devices
PROG BLOCK ID COPY CONFTIG
I/0 (devicereferences) FROM: n TO:
BLOCK NO . (device)
ref blk nxt chng entr
Field Control
Devices
Configure a Remote Configure an F1:GENIUS CONFIG
Map 1/0 Block F2:Module Config
F3:P i M
Remote I/O Scanner Genius Blocks Teviens end
and Remote I/O Scanner
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Completing the Program Block ID Screens

Select F1 (Program Block ID) from the
Configuration menu to complete the mandatory
part of a device’s configuration. (The HHM’s
CHNG BLK ID capability must be enabled).

When the HHM is set up for a PLC host, the
Program Block ID screen looks like this:

PROG BLOCK ID
I/0 (devireferences)
BLOCK NO. (device#)

ref blk nxt

If there are ? symbols on the screen, the
reference address and/or Device Number have not
yet been configured. If there are * symbols on the
screen, a reference address was previously
assigned, but is out of range for the host CPU
currently set up for the HHM. If this happens,
check the host CPU setup in the HHM Ultilities.

When the HHM is set up for a PCIM/QBIM/GENI
host, references are not used. Instead, the second
line describes the device:

PROG BLOCK ID
ISOL 8 (device#)
BLOCK NO. (device)

ref blk nxt

To Enter or Change the Device Number: the
Hand-held Monitor must be connected directly to
the device.

1. Press F2 (blk). Then, enter the intended num-
ber (1-30). If you make a mistake, press F2
twice again, then enter the correct number.

2. Press the F3 (Enter) key. If the device is on-line
and the number has already been used, an er-
ror message appears.
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To Complete the Program Block ID Screen: The
Program Block ID screen is used to configure
additional features for some devices. These vary
from device to device; you should refer to the
device’s User’s Manual if you need more
information.

To Change the Device’s Baud Rate: press F4
(Next) from the Program Block ID screen. (The
HHM'’s CHNG BLK BAUD capability must be
enabled).

SELECT BAUD RATE
ACTIVE=153.6K ST
PROG =153.6K ST

tgl entr nxt

The bus will not operate unless all devices are set for the
same baud rate. Check the baud rate before
introducing blocks onto an operating bus.

®  To change the device’s baud rate, press F2
(Toggle), then press F3 (Enter).

m Cycle power to all devices on the bus at the
same time to use the new baud rate.

To Set the I/0O Map for a Remote 1/0O Scanner:
The next screen is used to assign data types and
lengths for a Series 90-70 Remote I/0 Scanner. See
the next page.
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Configuring a Remote /0 Scanner

After selecting the baud rate, the next Program
Block ID screen is used to assign data types and
lengths for a Series 90-70 Remote I/0O Scanner.

PROG REMOTE MAP

%I

LENGTH(PTS)

tgl ref send nxt
Configuration Notes

The Remote I/0 Scanner User’s Manual explains
remote drop configuration in detail. You should
use it as a reference during remote drop
configuration.

Also, look over the information below. Especially,
note that it is not always possible or desirable to
use a HHM for remote drop configuration.

m [f the remote drop includes any Analog Expan-
der Modules, Logicmaster 90 must be used for
configuration; do not use a HHM.

® When a remote drop is configured with a
HHM, all I/0O modules will operate in default
mode; module aptions can only be configured with
the Logicmaster 90-70 software.

m  Unless the Remote I/0 Scanner is configuration
protected, pressing F3 (send) from the Remote
Map configuration screen causes the HHM to
automatically configure the remote drop. This
configuration will REPLACE any existingl/O
configuration (including one entered using Lo-
gicmaster 90-70), and return I/0 module op-
tions to their original defaults.

®  Remote drops configured with Logicmaster
90-70 are automatically protected. Please check
carefully before removing configuration protec-
tion with a Hand-held Monitor.

® The Hand-held Monitor automatically creates a
configuration for a nine-slot rack, regardless of
the actual rack size. If the remote drop has a
five-slot rack, the HHM will later assume that
there are unfilled slots. If this is a problem, Lo-
gicmaster 90-70 can be used for configuration,
or to edit an automatic configuration done with
a Hand-held Monitor. Then, the configuration
can be stored to the Remote I/0 Scanner.

Configuring the Remote Drop

To configure the remote drop with the HHM:

1.
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Enter a starting address and length for: %I (dis-
crete inputs), %Q (discrete outputs), %Al (ana-
log inputs), %AQ (analog outputs) on the
screen shown at left. The data lengths must
not add up to more than 128 bytes of inputs
and 128 bytes or outputs. If they do, an error
message will appear when you attempt to send
the data to the Remote I/0 Scanner.

Next, press F2 (drop) and enter a Remote Drop
ID (between 16 and 254).

PROG REMOTE MAP
DROP 1ID
tgl drp send nxt

Press the F3 (send) key to download these
selections to the Remote I/0 Scanner.

Note: Do not perform this step if you want to
preserve a configuration entered using the Lo-
gicmaster software.

The HHM configures the 1/0 references of Se-
ries 90-70 I/0 modules (only) in the remote
drop. It assigns references in ascending order,
starting with the slot next to the Remote I/0O
Scanner. The leftmost module of each type (%],
%Q, %AI or %AQ) in the rack receives the first
available reference of the appropriate type.

Press F4 (nxt) to go to the Program Block ID
screen.

After completing these screens, press F2 (Con-
figure Block) to complete the Genius configura-
tion screens, or to display information about
the I/0 modules in the remote drop.

The module description screens that appear
during the configuration sequence are read-
only; boards cannot be configured here.

Go through these block description screens to
configure:

® BSM Present

m BSM Controller

® CPU Redundancy

®  Configuration Protection
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Configuring Genius Blocks

To configure individual features of a Genius block,
the block must be the “active” device.

Selecting the Active Device

1. From the Analyze menu, select F3 (Block/Bus
Status).

2. Press F1 (Next) or F2 (Previous), to reach the
device’s description screen.

3. When the desired device appears, press F3 (Ac-
tive) to make it the active device. (On a dual
bus, the HHM must be on the same bus as the
active block. If it is not, either move the HHM
or force the bus selection as described on
page 5-3).

4. Press D MENU twice to return to the Main
Menu.

ConfiguringBlock Features

Select F3 (Configuration), then F2 (Config Block).
For Genius blocks, the HHM shows the first
configurationdisplay. For example:

PULSE TEST 0,
REF S (blockferences)
ENABLED

tgl entr nxt

The HHM shows the feature to be configured (in
the example above, it is the Pulse Test option). It
also shows the current status of that feature.

When the Hand-held Monitor is set up for a PLC
host, line 2 shows the references assigned to the
device being configured. If there are ? symbols on
the screen, the device’s reference address has not
yet been configured. If there are * symbols on the
screen, a reference address was previously
assigned, but it is out of range for the host CPU
currently set up for the Hand-held Monitor. If this
happens, check the host CPU setup in the HHM
Utilities.

When the HHM is set up for a PCIM/QBIM/GENI
host, line 2 shows the device type and Device
Number (serial bus address) instead.

Because there are so many different device
configuration screens, it is not possible to show
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them all here. You should refer to the User’s
Manual for the device you are configuring for
descriptions of its configuration screens and
detailed instructions for completing them.

Configuration Instructions

1. To advance through the HHM configuration
displays making changes as needed, use the F4
(Nxt)key. You can pass through feature dis-
plays without making entries.

2. To change a feature, use the TGL and CHNG
keys to select choices or enter other values. On
screens used to enter individual I/O circuit op-
tions, use the F1 (> ) key to choose a circuit,
then select the option using the TGL or CHNG
key. On some displays, you can enter new val-
ues from the keypad.

3. Press the F3 (Enter) key to save each change.

Copying a Configuration

If there are similar devices on an operating bus,
you can use the Copy Configuration feature to
copy the configuration from one to the another.
Both of the devices must have a Device Number
already configured, and they must be operating at
the same baud rate. The device to be copied TO
must not be Configuration Protected.

The device to be copied FROM must be the active
device (move the HHM to that block or select it
from the Block/Bus Status screen).

1. To begin, press F3 (Copy Configuration) from
the Configuration menu. The HHM shows:

COPY CONFIG
FROM: n TO:

chng entr

2. The Device Number of the active device ap-
pears next to the word FROM. Enter the De-
vice Number of the device being copied TO.
Press F3 (Enter).

3. Press the F4 (Execute) key. The configuration is
copied.
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Configuring Field Control Station

1. From the HHM Main Menu, display the special
set of menus for Field Control.

A. If the Bus Interface Unit or Field Processor is
the current-selected device, press F2 (ana-
lyze) twice or F3 then F2.

B. Ifitis NOT the currently-selected device:

m  Select F2 (analyze) then F3 (Block/Bus
Status).

m  Press the F1 (nxt) or F2 (prev) key repeat-
edly to reach the serial bus address of the
BIU or Field Processor. Press F3 to make it
the active device. Then, press AMenu, fol-
lowed by F2 (Monitor/Control Ref).

Fl:Monitor
F2:Configuration

From this menu, press F2 (Configuration). This
menu appears:

F1:GENIUS
F2: Module

CONFIG
Config

F3:Previous Menu

m Press F1 to configure the BIU/Field Processor.
®  Press F2 to configure individual modules.

Change the Bus Address

When you press F1 (Genius Configuration) from
the Configuration menu, the HHM shows the
serial bus address previously configured for the
BIU or Field Processor:

Device SBA
14
Prv > entr

If the bus address is correct, press F2 to go on.

Note: If a BIU or Field Processor has a Serial Bus
Address conflict on an operating bus, it will not
scan the modules in the station until the fault is
cleared.

1. If you want to change the address, enter the
new address using the keypad.

2. Press F4 (entr). An error message appears if
the number has been used for another device.

Select a PLC Reference Address
If the host is not a Series Six PLC or Series Five
PLC, no entry is necessary here.

If the host is a Series Six PLC or Series Five PLC,
assign an I/0 or register reference address.

Stat Tbl Addr
00000
< > I0O6 entr

shows reference type

1. Use the F3 key to toggle the selection of Series
SixI/Omemory, Series Five /O memory, or
register memory. (See the BIU/Field Processor
User’s Manual for information about memory
usage in the Series Five and Series Six PLC).

IfI/O memory is used, the amount required is
equal to the number of bits of discrete data
PLUS analog data. Each analog reference used
consumes 16 points.

If register memory is used, an amount is re-
quired that is equal to the total number of bytes
of input data PLUS all of the output data

2. Key in the number of the block’s beginning I/O
or register reference. This may be:

SeriesSixI/O 1to 993
Series Fivel /O 1 to 2041
Registers 1to 16383

3. Press the F4 (Entr) key.

Configure Additional Features

On the screens that follow, select these features:

Fault Reporting

Genius bus redundancy

BSM Controller

Output default time (for redundancy)

CPU redundancy

Duplex redundancy: default mode for outputs
Configuration protection
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Configuring Individual Field Control Modules

Go to the Field Control configuration menu:

F1:GENIUS
F2: Module

CONFIG
Config

F2:Previous Menu

From this menu, press F2 to configure the
individual modules in the station.

Disable the 1/0 Scan

While you configure the modules in the station,
you may want to disable I/O scanning. (The Bus
Interface Unit or Field Processor begins scanning
1/0 as soon as it is powered up).

IO Scan
DISABLED *
entr

Prv > tgl

When the I/0 scan is disabled, previously
unconfigured module inputs and outputs default
to 0. For previously-configured modules, inputs
and outputs either default or hold their last state
or value, as configured.

1. If you want to change the present selection,
press F3 (tgl).

2. Press F4 (entr). If you want to go to the next
screen without changing the selection, press F2

(>).
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Configure Data Addresses and Lengths

The next screens are used to assign the starting
addresses and lengths for I, then Q, then Al then
AQ data.

If the host is a Series 90 PLC, these should
correspond to the memory assignments made for
the BIU or Field Processor during PLC configuration.

If the host is a Series Six or Series Five PLC, only
the length selected here is used; the entry made
on the starting address screen is not used by the
PLC. For those PLC types, the starting address was
assigned on an earlier screen.

1. For each data type, enter a starting address for
discrete input data (I). For example:

Blk Map Start 1
I0O0001
< > entr

2. Press F4 to accept the value. Then, enter a
length in bits for I data. For example:

Blk Map Lngth
6 4

< > entr

3. Press F4 (entr) to accept the value.

4. Continue as above, entering starting addresses
and lengths for the other data types.

The lengths entered must not add up to more
than 128 bytes of inputs (discrete + analog)
and 128 bytes of outputs (discrete + analog).

5. Press F1 ( >) after entering the length for AQ
data (the fourth data type).

If you changed any starting address or length
entries, the HHM displays this screen:

Map has
Accept ?

changed

no yes

6. To accept the changes and continue to the next
menu, press F4 (yes).
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Add Modules and Assign References

The first module configuration screen looks like this:

Rack Slot

number number
RO:5s51 EMPTY
< > tgl read

Use F1 and F2 to display
another slot (module)

The Rack Number is always 0.
The Slot Number refers to the location of the
module relative to the BIU or Field Processor.

Read a Module Identification

If there is a module in the currently-selected slot,
pressing F4 (read) from the “empty slot” screen
brings up the module identification screen:

RO:8s1 Mod type?

D i & out 16 _ Module

iscrete u type
tgl entr

® If you want to change the module type dis-
played, press F3 (tg) to list other module types.

m  To accept the module type, press F4 (entr).

Select a Module Type

If a module is not present in the selected slot, press
F3 (tgl) to select GenericI/O or Special I/O. Then
press F4 (entr).

RO:s1 I/0 type?
Generic I/O
tgl entr

m Use the F3 (tgl) key again to go through the
module names.

® When the correct module name appears, press
F4 (entr).

Assign I/0 References for the Module

After you “accept” a module into the slot, a screen
like this appears:

RO:5s1
I

I1l6

entr

Specify the I/0 references to be used by the
module. For most applications, you can simply
have the BIU/Field Processor assign the next
available references in that memory type.

A. To assign the next available references, just
press F4 (entr).

B. If you want to assign specific references, enter
the starting address. Press F4 (entr).

Module references are automatically assigned by
the BIU or Field Processor based on its configured
data addresses and the number of points
appropriate for the module type.

Editing a Module Configuration

To edit the module’s configuration, press F4 (zoom).
Refer to the module configuration instructions in the
BIU/Field Processor User’s Manual.

Delete an Existing Module Configuration

To delete the configuration of the module in the
present slot, press F3 (delete) then F4 (enter). Note
that this remaves the entire module configuration.

Configuring Module Features

Configure additional module features as described in
the BIU/Field Processor User’s Manual. For example:

®m Change the module’s reference address.
®  Module Fault Reporting (discrete)

m Default inputs (or outputs) or Hold Last State
(discrete and analog)

Channel Fault Reporting (analog)
Channel Active (analog)

Input Current/ltage Ranges (analog)
Input or output scaling (analog)

Alarm thresholds (analog)

Output default values (analog)
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Chapter

5

Monitoring the Bus and its Devices

This chapter explains how to perform monitoring and control operations with the Hand-held Monitor.

Displaying Information About Bus Devices (page 5-2).

O Selecting the Active Device (page 5-2).

0 Clearing Faults (page 5-3).

Display fora Bus Controller (page 5-3).
Monitoring the Bus Status (page 5-3).
Switchinga Dual Bus (page 5-3).
MonitoringaGeniusBlock (page 5-4).

o Discrete /O and Input Blocks (page 5-4).
Discrete Relay Output Blocks (page 5-5).
Analog Blocks (page 5-5).

RTD or Thermocouple Blocks (page 5-5).
High-speed Counter Block (page 5-6).
PowerTRAC Block (page 5-7).

0O 0O00a0o

Monitoringand ControllingIndividual Circuits on a
GeniusBlock (page 5-8).
o Discrete, Relay, High-speed Counter Block (p. 5-9).
- Forcing an Input or Output (page 5-9).
- Clearing Circuit Faults (page 5-9).
O Analog, RTD, or Thermocouple Block (page 5-10).
- Forcing an Analog Value (page 5-10).
- Clearing Circuit Faults (page 5-10).
o0 PowerTRAC Block (page 5-11).
- Forcing PowerTRAC Data (page 5-12).
- Diagnostics (page 5-12).
Monitoring/Controlling Remote Drop Data (page 5-13).
- Forcing a Circuit (page 5-14).
- Displaying and Clearing Faults (page 5-14).
Monitoring/Controlling Field Control Data (page 5-15).
- Forcing/Unforcing the Reference (p 5-15).
- Displaying and Clearing Faults (page 5-16).
Pulse Testing Outputs on Discrete Blocks (page 5-17).

F1:HHM UTILITIES
Monitoring and Operation F§=ICH;ALY<Z;E .
F3: NFIGURATION
HHM Menus F4:DEVICE MEMORY
F2 or F3
1] .
| (Field Control)
F1:MONITOR BLOCK Fl:Monitor
F2:MNTR/CNTL REF . .
F3:BLOCK/BUS STS F2:Configuration
F4:PULSE TEST
. P |
F1 (Genius) |
REF S (block referencesp; F4(Gemus) Fl:Monitor I/O
F2:F 1t
S Pulse Test aults
AS 11 011 { (I) B 1 discreteoutputs F3:Previous Meny
F2(Genius) | | F3 (All Devices)
MUTR 4435 e4n| | prrs evicerstorencony Select the
NO FAULTS FORCED,NO FAULTS| v Active Device
> force reles nxt prv actv bus here
SERIAL BUS STATS
ACTV DEVICES-S= 7
SCA N TIME= 10ms
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Displaying Information About Bus Devices

Select F3 (Block/Bus Status) from the Analyze
menu to:

m Display the references assigned to any device.
m Display the revision level of any device.

m Display the description and Global Data ad-
dress of a bus controller.

m Display the fault status of a Genius block or
Remote I/0 Scanner (remote drop).

m  Select the active device.
m  (Clear all faults on the active device.
®m  Access the Bus Status display.

This screen provides a quick way to check for faults
and forced circuits before starting up a system.

Block/Bus Status Displays for Bus Devices

Example displays are shown below. (Display format
for bus controllers is shown on the next page).

Genius Block (discrete)

REF S (devicereferences$;

DC16K 15 v2.0OACT

FORCED,NO FAULTS

nxt prv actv bus
Remote I/O Scanner

REFS * * G

RIO 15 v3.5ACT

NO FORCE,FAULTS

nxt prv actv bus
BIU/Field Processor

REFS * *  Op

fldpr 20 v1.OACT

N O FORCE

nxt prv actv bus

Line 1 shows the IO references used by the device.
If * symbols appear instead of references, the
device’s references are incorrect for the type of host
CPU currently set up for the HHM. For example, if
a device is assigned to Series Six registers, and the
HHM is set up for a Series 90 host, the HHM will
display * symbols instead of references.
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Line 1 also provides information about the device
currently being displayed:

I = Inputblock

0 = Outputblock

0; = Blockwithboth inputsand outputs

A = Analog,RTD or Thermocoupleblock

G = PowerTRACblock or Remotel/O Scanner

Line 2 identifies the device and shows its serial bus
address (also called its Device Number or block
number), and its revision level.

Line 3 shows whether the device presently has
any forces or faults. If the device is a Field Control
BIU or Field Processor, however, the presence of
faults is not indicated on this screen.

Selecting Another Device

Press F1 (Next) or F2 (Previous) as needed to
display information about other device.

Note: Poor bus conditions may cause the HHM to
skip (not display) a device that is present on the
bus. Try moving the HHM to a different
connector on the bus. Occasionally, this problem is
caused by certain older Genius blocks that do not
communicate with the HHM properly. If the
problem persists, such blocks can be upgraded.

Selecting the Active Device

Initially, the active device is the one to which the
HHM is connected.

You can display information about other devices
without making them “active”.

However, for many functions the HHM must be
attached to another device or the other device must
be made “active” by following the steps below.

1. From the Analyze menu, select F3 (Block/Bus
Status).

2. Press F1 (Next) or F2 (Previous), to reach the
device’s description screen.

3. When the device’s screen appears, press F3
(Active) to make it the active device. (On a
dual bus, the HHM must be on the same bus as
the active block. If it is not, either move the
HHM or force the bus selection)

4. Press D MENU to return to the Analyze menu.
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Clearing Faults from the Block/Bus Status Screen

Pressing the CLEAR key from this screen clears all
faults on the active device. For Genius blocks, if
you want to clear a specific circuit fault, select F2
(Monitor/Control Reference) from the Analyze
menu instead.

Block/Bus Status Display for a Bus Controller

If the active device is a bus controller, the Block Bus
Status display shows information appropriate to that
bus controller type. For example:

SERIES 6

BUS ADR: (device #) (vers)
REG (registers)

nxt prv r/g bus

The first line identifies the bus controller type. If it
is a Series Five bus controller, PCIM, or QBIM, the
first line indicates:

GENI

The second line of the display shows the bus
controller’s Device Number followed by its
firmware revision level.

Reading a Global Data Address

The third line of a bus controller’sBlock/BusStatus
screen shows its assigned Global Data address.

If no Global Data address appears, it means that
either:

m  The bus controller has no Global Data address.

®m A Series 90-70 bus controller has a Global Data
address in %I, %Q, %Al, %AQ, or %R memory,
and no optional Series Six register address was
configured for the bus controller.

If a Global Data address has been set up, you can
use the F3 (R/G) key to toggle between (R)egister
and (G)lobal memory format. If no Global Data
reference has been set up, the F3 key is not assigned.

Monitoring the Bus Status

To display the number of devices currently operating
on the bus, and the current bus scan time, select F4
(Bus) from the Block Bus Status display.

SERIAL BUS STATS
ACTV DEVICES-= 7
SCAN TIME 1Oms

The bus scan time shown is rounded down to the
nearest millisecond (10mS represents 10.01 to
10.99mS).

Switching a Dual Bus

To force a bus switch in a redundant bus system,
the HHM must be connected to the same bus as
the presently-active device.

1. If necessary, make the BSM Controller the ac-
tive device.

A. From the Analyze menu, select F3 (Block/
Bus Status).

B. Press F1 (Next) or F2 (Previous), to reach the
status screen for the BSM Controller.

C. When it appears, press F3 (Active) to make
the BSM Controller the active device.
2. Press D MENU to return to the Analyze menu.

3. From the Analyze menu, select F2 (Monitor/
Control Reference). The HHM shows the ac-
tive bus and whether it is forced. For example:

MNTR/CTRL
STATE :

(input ref)
BUS B FRC

> busA bisB rels

4. Press F2 or F3 to select the other bus. The LED
on the BSM is off when bus A is selected and
on when bus B is selected. The I/0 Enabled
LED on each block on the active bus blinks.
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Monitoring a Genius Block

Select F2 (Monitor Block) from the Analyze menu to:

m Display the I/0 type of all circuits on the active
block.

m Display (not change) forces on the active block.

m Display the bus presently selected by the BSM
Controller.

Making the Block Active

If the block is not presently selected as the “active”
block, follow the steps below.

1. From the Analyze menu, select F3 (Block/Bus
Status).

2. Press F1 (Next) or F2 (Previous), to reach the
device’s description screen.

3. When the block’s screen appears, press F3 (Ac-
tive) to make it the active device. (On a dual
bus, the HHM must be on the same bus as the
active block. If it is not, either move the HHM
or force the bus selection)

4. Press D MENU to return to the Analyze menu.

After selecting the active device, use F1 (Monitor
Block) to monitor its data. This is a example
display for a discrete I/O block:

REFS (blockreferences) o
3 4 5 6 7 8 9
B, O O T O o o0

s I I 1 1
A 1 O 1 1 O O

H

=1 O

Monitor Block screens for other types of Genius
blocks are described below.

Block References

On all the Monitor Block screens for a Genius
blocks, line 1 shows the block references. If *
symbols appear instead, the references are out of
range for the CPU host currently setup for the
Hand-held Monitor. For example, if a block is
assigned to Series Six registers, and the HHM is set
up for a Series 90 host, the HHM displays
*symbols instead of references.

If the HHM is set up for PCIM mode, references
are not used; a device description appears instead.
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Monitor Block Display for Discrete /0
and Input Blocks

For a discrete block, the Monitor Block display
shows the I/0 type and current state of each
circuit. This is an example display for an 8-circuit
groupedI/Oblock:

REF S (block references) o
3 4 5 6 7 8 9
B, O O I O o o

S I I 1 1
A 1 O 1 1 O O

H

= H O

Line 1 indicates the block’s I/0 type:

I = Input
o = Output
0; = Combinatior(I/O)

Line 2 shows the last digit of each circuit’s
reference address. The abbreviation on line 3
describes the I/0 type of each circuit:

I = Input

1 = Tri-State input

0 = Output

o; = Output with feedback

Bs = Circuit that controls a BSM

Line 4 shows the current state of each circuit. This
information is updated continuously as the [/O
states change.

An underline means a circuit is forced (and does
not reflect actual circuit status):

OFF
forced OFF
ON

forced ON

= =10 O

If the circuit is configured as a BSM controller, the
selected bus is displayed on line 4. If forced, the
active bus letter is underscored.

busA
forced tobus A
bus B
forced to bus B

oo o>

Displaying Additional Circuits for a 32-circuit DC
block: Press a key from F1 to F4 to toggle the
display between circuits 1 to 16 and circuits 17 to 32.
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Monitor Block Display for Discrete Relay
OutputBlocks
For a Relay block, the Monitor Block screen shows

the current open (O) or closed (C) states of all
relay outputs:

REFS (blockreferences)O
1234567890123456
000000O0O0O0O0O0O0O0O0OO0OO
ooooccooooocoocc

Line 2 shows the last digit of each circuit’s
reference address. The ‘O°s on line 3 show that
each circuit is an output. Line 4 shows each relay
output’s present state. An underline means the
relay is forced.

open
forced open
closed
forcedclosed

InQlo o

Monitor Block Display for Analog Blocks

For an analog block, each Monitor Block screen
shows the current value of two circuits at a time.
This is an example display:

REF S (circunéferences) A
I1c: 18357
I2: 29061
>

FRC

Line 1 indicates that the block is an (A)nalog block.
Lines 2 and 3 display the current values of two
circuits. On an analog block, each circuit may
report either unconverted analog data, or data
that has been scaled to be suitable for the
application.

The abbreviation FRC means a value is forced.

Press F1 (>) to display the next pair of circuits.
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Monitor Block Display for RTD or
Thermocouple Blocks

For an RTD or Thermocouple Input block, the
Monitor Block screen shows the current values of
two inputs at a time. Values reported by the block
may be tenths of degrees (Celsius or Fahrenheit),
tenths of ohms, or unconverted counts. This is an
example display showing tenths of degrees
Celsius:

REF S (circuneferences) A
I1: 150.0 ¢
I2: 25.5 ¢C

Line 1 indicates that the block is an (A)nalog block.
Lines 2 and 3 display the input values. The
abbreviation FRC means a value is forced.

Press F1 ( >) to display the next pair of inputs.



Monitor Block Display for a High-speed Counter Block

For a High-speed Counter block, the Monitor
Block function displays a sequence of screens with
the following information:

1. The states of the block’s four Preset Outputs.
2. The states of the block’s Control Inputs.

3. The current values of the block’s internal data
storage registers: Accumulator, Counts per
Timebase, and Strobe.

The exact appearance and sequence of screens
depends upon whether the block has been set up
for four-counter (Type A), two-counter (Type B), or
one-counter (Type C) operation. The letter a, b, or
c on the top line of the screen shows how the
block is set up.

Preset Oulputs
First, the Preset Outputs are displayed:

REF (ctrnumber) (ctrtype)
PRESET OUTPUT

1 2 3 4

(0] (0] (0] (0]

Outputs that are forced are shown with an
underscore (forced outputs do NOT respond to
the actual value of the counter).
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Control Inputs
Press F1 (>) to display the block’s Control Inputs:

CONTROL INPUTS <c
1 1 1 2 1 2 3
D H P P S S S
1 1 1 1 1 1 O

On this screen, the numbers on line 2 identify the
first, second, third, of fourth control input of the
same input type on the block. The third line
identifies the input type: Disable Input (D), Home
Input (H), Preload Input(P), or Strobe Input (S).
The screen’s bottom line shows the current state of
each Control Input.

Register Values

Press F1 (>) to display the current value in each
counter s accumulator, Counts-per-Timebase
register, and Strobe register(s):

REF (number )(countertype)
ACC 1:_ + (acc.value)
CTB 1: + (countvalue)
> nxt

Use the F1 ( >) key to display the strobe value(s),
and additional values appropriate to the counter
type. For more detailed instructions for using a
Hand-held Monitor with a High-speed Counter,
refer to the High-speed Counter User’s Manual.
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Monitor Block Display for a PowerTRACBlock

If the active device is a PowerTRAC block, the
HHM’s Monitor Block function displays the
following screens:

®  One screen showing the states of all of the
block’s Status Inputs.

®m Individual screens showing the block’s current
calculated data values. In the Monitor Block
function, these values are NOT labelled. It is
easier to display this information using the
Monitor/Control Reference function (F2), be-
cause those displays are labelled.

®  One screen showing the states of all of the
block’s Control Outputs.

On each of these screens, you can press F1 (>) to
display next screen, or press F2 (ref) and enter a
reference location to display a specific screen. For
a sequential list of the PowerTRAC block data, see
page 5-11.

Status Inputs

The Monitor Block function first displays the
PowerTRAC block’s Status Inputs:

REF (inputreferences) I
1234567890123456
0001100000010000
> ref

Line 2 indicates each of the 16 possible bit
locations for status data. Lin e3 shows the current
states of all inputs.

Bits 1 — 3 indicate the status of table data transfer,
for datagram communications.

Bit 4 = 1 indicates the block has captured an over-
current event.

Bit 5 should always be 1, indicating that the block’s
phase-lock loop is synchronized with the
incoming AC voltage.

Bit 12 = 1 means the overcurrent event indicated
by bit 4 occurred on phase A.

Bit 13 = 1 means the overcurrent event indicated
by bit 4 occurred on phase B.

Bit 14 = 1 means the overcurrent event indicated
by bit 4 occurred on phase C.

Bit 15 = 1 means the overcurrent event indicated
by bit 4 occurred on the auxiliary current
line.

Bit 16 = 1 indicates an internal calculation has re-
sulted in an out-of-range value. The block
should be reconfigured to prevent this.

Calculated Data

After the Status Inputs, the HHM displays the
block’s calculated data. If the PowerTRAC Block is
version 2.3 or later, this includes the additional
“low-priorityl/O” data listed on page 5-11.

REF (input reference) I

Control Oulputs

After the calculated data screens, the HHM'’s
Monitor Block function displays the PowerTRAC
block’s Control Outputs. You can also display this
data by using the F2 (ref) key to select output 1.
You may need to toggle (F2) the memory type.

REF (outputreferences) O
1234567890123456
0000000000000 0OO0OO0
> ref

Line 2 indicates each of the 16 possible bit
locations for Control Outputs. Line 3 shows the
current state of each Control Outputs. These
outputs are communications handshaking bits,
sent from the CPU to the block for certain
datagram communications. Information about
these outputs is in the PowerTRAC Black User’s
Manual
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Monitoring and Controlling Individual Circuits on a Genius Block

Select F3 (Monitor/Control Reference) from the
Analyze menu to:

m  Display the present state or value of any circuit

on the active block.

Display the diagnostics status of any circuit.
Force and unforce individual circuits.

Force a bus switch on a dual bus.

Clear individual circuit faults.

Making the Block Active

The block whose circuits will be monitored or
controlled must first be made “active” by following
the steps below.

1. From the Analyze menu, select F3 (Block/Bus
Status).

2. Press F1 (Next) or F2 (Previous), to reach the
device’s description screen.

3. When the block’s screen appears, press F3 (Ac-
tive) to make it the active device. (On a dual
bus, the HHM must be on the same bus as the
active block. If it is not, either move the HHM
or force the bus selection)

4. Press D MENU to return to the Analyze menu.

From the Analyze menu, press F2.
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Basic Monitor/Control Display Format

Each Monitor/Control Reference screen provides
information about one circuit, channel, or data
value. For example:

MNTR 441— 464A
I2: —19370

NO FAULTS

> force reles

Line 1 shows the references used by that circuit. If
these are out of range for the host CPU set up for
the Hand-held Monitor, line 1 instead shows:

| MNTR (circuit number) + * A

For example, the first circuit on the block appears
as: 1+*

If the HHM is set up for PCIM mode, references
are not used; a block description appears instead.
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Monitor/Control Reference Display for a Discrete, Relay, or High-speed Counter Block

For a discrete, Relay, or High-speed Counter block,

the Monitor/Control Reference screen looks like
this:

MNTR/CNTL (reference) I
STATE: (0]
NO FAULTS
of f

> on reles

Line 1 identifies the circuit currently being
monitored. Pressing F1 (>) displays other
circuits.

Line 2 shows the state of the circuit. In the
example above, the circuit is OFF and not forced
(no underline). Status is obtained directly from
the block for both inputs and outputs. If the
circuit is an output and no-load sensing is
enabled it reflects the current flow out of the [/0
block to the load, as well as voltage at the field
terminals; otherwise, it indicates only the voltage
at the field terminals (output from the switch).

Forcing an Input or Output

(The Hand-held Monitor’s circuit forcing
capability must be enabled to force or unforce a
circuit). To force a circuit on, press F2 (ON). To
force it off,press F3 (OFF). The force remains until
changed by the HHM (even through loss of block
power). To clear a force, press F4 (reles).

Diagnostics

Line 3 of the Monitor/Control Reference screen
shows whether the circuit has any faults. If it
does, one of the following diagnostic messages
appears:

Failed switch: The commanded state of the circuit
does not match the actual state of the
switch or load.

Loss of I/O power: One pair of circuits on an dis-
crete isolated block is not receiving power.

No load: The load is drawing less than the block’s
minimum current level.

Open wire: An open wire condition has been de-
tected on a tristate input.

Overload: The output exceeds the block’s steady
state current limit.

Overtemperature: The block’s internal tempera-
ture exceeds 100°C.

Short circuit: Transient current above the block’s
short circuit limit.

Clearing Circuit Faults

After correcting a fault condition, press the CLEAR
key to remove the message and restore the
reference to normal operation (the Clear Block
Faults function must be enabled to use this
feature). If the fault condition still exists, the fault
message will reappear.
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Monitor/Control Reference Display for an Analog, RTD, or Thermocouple Block

For an analog, RTD, or Thermocouple block, the
Monitor/Control Reference screen shows the
current value for each circuit. For example:

MN TR (ckt. reference) A
I2: -19370
NO FAULTS

> force reles

For an analog block, the values may represent
either engineering units or unscaled analog data.

For an RTD or Thermocouple block, the values
represent tenths of degrees (Celsius or
Fahrenheit), tenths of ohms, or unconverted
counts.

Press F1 (>) to display other circuits.

Forcing an Analog, RTD, or Thermocouple
Value

The HHM'’s circuit forcing capability must be
enabled to perform this function.

1. Press F2 (Force) to force the displayed circuit.

2. If you make a mistake entering a value, use the
Clear key to delete one digit at a time, starting
with the last. To exit without forcing a circuit,
press F2 (Change).

3. Press F3 (Enter) to save this value as the value
for the circuit. The forced value will remain
until you press F4 (reles), or enter a new value.
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Diagnostics

Line 3 shows whether the circuit has any faults. If
it does, one of these messages appears on line 3:

Feedback error: There is a wiring error or other
hardware fault on a Current-source Ana-
log block. The output’s actual current dif-
fers from the commanded current by

more than 250mA.

High alarm/low alarm: An analog input value ex-
ceeds its high or low alarm limit.

Input shorted: An RTD input circuit measurement
is less than expected for the RTD type.

Internal fault: Internal calibration readings for a
pair of RTD circuits are out of tolerance.

Open wire: On an RTD block, the RTD is missing
or faulty, or there is an open wire. On an
analog block, an input configured for 4 to
20mA has less than 2mA present.

Overrange/underrange: An analog or RTD circuit
exceeds its maximum value.

Overtemperature: The block’s internal tempera-
ture exceeds 100°C.

Wiring error: There is a faulty connection be-
tween an RTD and the block.

Clearing Circuit Faults

After correcting a fault condition, press the CLEAR
key to remove the message and restore the
reference to normal operation (the Clear Block
Faults function must be enabled to use this
feature). If the fault condition still exists, the fault
message will reappear.
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Monitor/Control Reference Displays for a PowerTRAC Block

For a PowerTRAC block, the Monitor/Control
Reference function displays:

® 16 screens, each showing the state of one Status
Input. This information is more easily dis-
played with the Monitor Block function,which
shows all 16 Status Inputs on one screen. See
page 5-7.

m  Individual labelled displays of the block’s current
calculated data values. For PowerTRAC block
version 2.3 or later, this includes the “low-priority
1O "screens described on the next page.

® 16 screens, each showing the state of one of the
block’s Control Outputs. Control outputs are
also more easily displayed using Monitor Block.

PowerTRAC Data Sequence

The following table shows the sequence of
PowerTRAC block data that can be displayed on
the Monitor/Control Reference screens:

Input
Word
1| Statusinputs

(16 screensinMonitor/Control Reference)

2| Voltage phase AtoB
3| Voltage phase Bto C
4 | Voltage phase Cto A
5| Voltage A to N (Line-to-neutral PTs only)
6| Voltage B to N (Line-to-neutral PTs only)
7 | Voltage C to N (Line-to-neutral PTs only)
8 | Current phase A
9 | Current phase B

10 | Current phase C

11 | Auxiliary CT current

12 | Active power phase A

13 | Active power phase B

14 | Active power phase C

15 | Reactive power A

16 | Reactive power B

17 | Reactive power C

18 | Total power factor

19 | Accumulated power

CalculatedData

20 | Fundamental VARsphase A

21 | Fundamental VARs phase B

22 | Fundamental VARs phase C

23 | Fundamental Power Factor, total

Harmonic VARS as % of V-A, phase A

25 | Harmonic VARS as % of V-A, phase B

26 | Harmonic VARS as % of V-A, phase C

27 | Harmonic VARS as % of V-A, total

28 | Line Frequency

29 | TemperatureAlarm Status

30 | Extended Watt-hour accumulator (upper 5 digits)
31| Extended Watt-hour accumulator (lower 3 digits)

32-64 | notused

Low-P riority I/O Data
BN

Output | Control outputs
Word 1 | (16screensinMonitor/Control Reference)

For explanations of the data provided by a
PowerTRAC block, see the PowerTRAC Block User’s
Manual

Selecting a Memory Type or Address

To select a specific data item, you can enter its
memory type and/or address. Press F2 (ref). This
screen appears:

MNTR

tgl chng entr

1. Enter the reference number and press F3 (entr).
If the HHM is set up for a PLC host, I/O refer-
ences increment by 16 and word (register) refer-
ences increment by 1. For a PLC host, both1/0
and word references start at the first reference
assigned to the block. If the HHM is set up for
aPCIM/QBIM/GENTI host, references begin at 1
and increment by 1.

2. The memory type blinks on the screen. To
change the memory type, use the F2 (tgl) key.

3. Press F3 (entr) to display the information.
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PowerTRAC Status Inputs Screens

First, the Hand-held Monitor displays 16 screens
showing the states of Status Inputs:

MNTR/CNTL (references) O

STATUS INPUTS
STS o
> ref force diag

To display additional data, press the F1 ( > ) key.

PowerTRAC Calculated Data Screens

After the Status Inputs, the HHM displays the
block’s calculated data values. Lines 2 and 3
identify the data being displayed and show its
present value. In the example below, voltage A to
Nis 117 volts.

MNTR (input references) 1

Van
STS 117
> ref force diag

PowerTRAC Extra Calculated Data (LPIO)
Screens

If the PowerTRAC block is version 2.3 or later, the
Hand-held Monitor next shows a series of screens
with extra calculated (“Low-Priorityl/O”) data.
The block may or may not automatically provide
this data to the host, depending on the block’s
revision level and configuration. A CPU can use
datagrams to read the data.

LPIO #1WwW 20 1
FUND. VAR a

STS —-270

> ref diag

On these screens, the top line shows the serial bus
address of the block and the relative data word
being displayed. For example, the screen above
shows the 20th input word (Fundamental VARs
for phase A). This area of line 1 blinks as a
reminder that the numbers shown are not
reference addresses.
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PowerTRAC Control Outputs Screens

Finally, the HHM displays 16 screens showing the
states of individual Control Outputs (datagram
handshaking bits). If you use the F1 (>) key to
reach the Control Outputs, notice that there are
several unused references following the Extra
Calculated Data data. You can use F2 (ref) to go
directly to output 1. You may need to toggle the
memory type to %Q (or O, depending on the host
CPU setup of the HHM).

MNTR/CNTL (reference) O
CONTROL OUTPUTS

STS 0
>ref force diag
Forcing PowerTRAC Data

(The HHM'’s circuit forcing capability must be
enabled to perform this function). Display the
data you want to force. Press F3 (force).

For bit data, the HHM displays:

mon on off reles

Press F2 (on) or F3 (off). To release the force, press
F3 (reles).

For word data, the HHM displays:

STS 4

force release

Press F2 (force). The screen next displays:

FORCE TO:

chng entr

Press F2 (chng). Enter the force value, then press
F3 (entr). To release the force, press F4 (release).

Diagnostics

The PowerTRAC block does not report circuit
faults. If you use the F4 (diag) key from the
Monitor/Control Reference screen, the message
NO FAULTSwill appear.
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Monitoring/Controlling Remote Drop Data

The HHM can display diagnostics and currentl/O
states, and force and unforce individual I/O points
on I/0 modules in a remote drop.

When the active device is a Remote I/0 Scanner,
the HHM'’s Monitor Block and Monitor/Control
Reference functions display the same set of
screens. This is unlike HHM operation for Genius
blocks, where the screens for Monitor Block and
Monitor/Control Reference are different.

For the Remote 1/0 Scanner, the monitoring
screens provide the following information:

1. The states of the discrete inputs in the remote
drop, in ascending order.

2. The values of the analog inputs in the remote
drop, in ascending order.

3. The states of the discrete outputs for the re-
mote drop, in ascending order.

4. The values of the analog outputs for the re-
mote drop, in ascending order.

On each screen, line 3 shows the state or value of
one circuit at a time. It also indicates whether the
circuit is forced, or has a fault as illustrated below.
The first screen that appears is the Monitor screen
for the module with the first %I reference.

MNTR

143#0.2 81

STS (0] FAULT
> ref force diag

Line 1 shows the relative number in the word of
the circuit being monitored:

MNTR 1

Here, it is the first circuit on the block. The second
line identifies the I/O module being monitored:

143#4 .2 %I 1

It shows the Remote Drop ID (143 in this
example), the rack number (0),the slot number (2),
and the memory type (%I). The number on the
righthand side of the second line represents a data
word.

143 #4 .2 81 1

L Startingreference
(groups of 16)

Reference Type
Slot Number

Rack Number

Remote ID Number

The Series 90-70 I/0 reference for the circuit is one
less than the sum of the two numbers on the
righthand side of the HHM screen. For example:

MNTR 3
143#4 .3 s8I 33

3+33-1=35

In this example, the circuit being monitored is
%10035.

Displaying Other Circuits

To display additional circuits, press the F1 (>) key.
The HHM will step through each available circuit.
To jump directly to a particular device, memory
type, or address, press F2 (ref). This screen
appears, to enter the desired information.

MNTR 3

tgl chng entr

1. Enter the reference number. Press F3 (entr).
The memory type blinks on the screen.

2. If you want to select a different reference type
(for example, to display%AQ instead of %l),
press F2 (chng) to toggle the memory type.

3. With the desired information displayed, press
F3 (entr) to monitor the circuit.
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Forcing a Circuit

(The HHM'’s circuit forcing capability must be
enabled to perform this function). Display the
circuit you want to force. Press F3 (force).

For a discrete circuit, the HHM displays:

mon on off reles

Press F2 (on) or F3 (off) to force the circuit. The

forced state appears on line 3. To release the force,

press F3 (reles).
For an analog circuit, the HHM displays:

STS 4

force release

Press F2 (force) to force the circuit. The screen
next displays:

FORCE TO:

Press F2 (chng). Enter the force value, then press
F3 (entr). The forced value will appear on line 3.

FRC 1

> ref force

diag

To release the force, press F4 (release) from the
force/releasescreen.
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Displaying and Clearing Remote Drop Faults

To display diagnostics for a circuit, press F4 (diag)
from the Monitor screen. If there is a fault, it
appears on line 3. For example:

DIAG

143#0.3 8&I 33
OVERCURRENT

mon nxt

If there is no fault on the circuit you are
monitoring, the Hand-held Monitor searches the
Remote [/0 Scanner’s internal fault table to see
whether there are any faults on the remote drop.
If there are any uncleared faults on the remote
drop, the HHM displays the fault that occurred
first (the oldest fault). For example:

DIAG 3
143#0.2 S%AI 1
UNDERRANGE

mon nxt

The HHM identifies the location where the fault
occurred (on line 2). From this screen, you can
display additional faults on the remote drop by
pressing F4 (nxt). Faults will appear in the same
sequence in which they occurred. For example,if the
fourth oldest is being shown, pressing F4 (nxt)
displays the fifth oldest, and so on.

To return to the Monitor screen you started from,
press F1 (mon).

Clearing Faults

After correcting fault-causing conditions, you can
return to the Block/Bus Status menu to clear all
fault messages for the remote drop. (The Clear
Block Faults function must be enabled to use this
feature).

GFK-0121E



GFK-0121E

Monitoring/Controlling Field Control Data

The HHM can display diagnostics and currentl/O
states, and force and unforce individual I/O points
on Field Control modules.

1. From the HHM Main Menu, display the Field
Control main menu.

Fl:Monitor
F2:Configuration

A. If the BIU or Field Processor is the active de-
vice, press either F3 (Configuration) or F2
(analyze) twice.

B. Ifitis NOT the active device select F2 (ana-
lyze) then F3 (Block/Bus Status).

m Press the F1 (nxt) or F2 (prev) key re-
peatedly to reach the serial bus address
ofthe BIU/Field Processor. Press F3 to
make it the active device.

® Then, press AMenu, followed by F2
(Monitor/ ControlRef).

2. Press F1 (Monitor). This menu appears:

Fl:Monitor I/O

F2:Faults

F3:Previous Menu

3. Select F1 (monitor I/0) to display the Monitor
screen for the first %I reference.

Indicates force is in effect

Reference
being Current
monitored \ state or value
I0O0001 =*O B
< > frc hex

Changingthe Reference Type Being Displayed

Use the F1 (<) key to select a reference type: |
(discrete inputs), Q (discrete outputs), AQ (analog
outputs), or Al (analog inputs).

Displaying Another Reference

Use the F2 (> ) key to advance through the point
reference screens for the selected reference type.

Changing the Display Mode

The letter in the upper right corner of the display
shows the present data type:

B binary
H hex
D decimal

Use the F4 (mode) key if you want to change the
display data type.

Returning to the Previous Menu

Press the HHM Clear key when you want to
return to the main Field Control menu.

Forcing/Unforcing the Displayed Reference

I/0 points can be forced and unforced from the
Hand-held Monitor (the HHM'’s circuit forcing
capability must be enabled to use this function).
Forcing an I/0 point changes its state in the Field
Processor’s EEPROM memory. If the circuit is an
output, the physical state of the output also
changes. If the circuit is an input, the forced input
data is sent to the CPU. A circuit retains its forced
state or value if power is removed. The forced
circuit ignores data from an attached input device,
or output data from the CPU. The force can
ONLY be removed from the Hand-held Monitor.

1. If the display is set to hex (H) or binary (B),
change it to decimal (D) by pressing F4.

2. Press the F3 (force) key to force the reference
now being displayed.

I0O0O001 =*1 D

frc unfrc

3. Press F3 (force) again. Then, enter the forced
state or value. The HHM displays an asterisk to
indicate the state of value now shown is forced.
See the illustration at left.

4. Use the F4 (unforce) key from the same screen
when you want to unforce the point.
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Displaying Field Control Faults

A Hand-held Monitor can display faults from a
Bus Interface Unit or Field Processor while
attached anywhere on the Genius bus.

1. From the HHM Main Menu, display the Field
Control main menu (instructions are on the
previous page).

Fl:Monitor
F2:Configuration

2. From this menu, select F1 (Monitor). The fol-
lowing menu appears:

Fl:Monitor I/O
F2:Faults
F3:Previous Menu

3. Select F2 (faults) to display fault information
for the Field Processor and its modules.

The Faults menu appears:

F1 First 16 Flts
F2 Last 16 F1lts
F3 Previous Menu

4.

Press F1 to display the first set of 16 faults (one
fault at a time). For example:

Slot #1 Fault#1
EXTRA I/O0O MODULE

< > exit

A. Use F1 and F2 to display another fault

B. If there are no faults, the HHM displays the
message: NoFaults on the top line.

To display the last 16 faults (if any):

A. Press F4 (exit) to return to the screen shown
at the top if this page.

B. Press F2 (last 16 faults).

Clearing Field Control Faults

If faults are present, pressing the HHM Clear key
here has no effect. To clear faults from the
Hand-held Monitor you need to do the following:

1.
2. PressF2 (Analyze).

3.

4. Make the BIU or Field Processor the active de-

5.

Return to the HHM Main Menu.

PressF3 (Block./Bus Status).

vice if it is not.

Press the Clear key.

Clearing faults from the Hand-held Monitor does
not clear faults at the host PLC. To keep the entire
system in step and up-to-date, fault clearing
should be performed from the host PLC.

Hand-held Monitor User’s Guide — June 1994
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Pulse Testing Outputs on Discrete Genius Blocks

Pulse Testing verifies the ability of outputs on a
discrete block to change state. Pulse Testing also
indicates whether output circuits (wires, power
sources, loads) will start or stop current flow.
Pulse testing is recommended for blocks
controlling outputs that seldom change state. It
provides assurance that when needed, an output
will operate correctly. Blocks that control outputs
which frequently change state do not need to use
the Pulse Test feature. Pulse Testing does not
provide enough energy to activate mechanical
devices such as motor starters, relays, or solenoid
valves, but it may change the state of a very small
load.

Executing a Pulse Test

(To execute a Pulse Test, the Hand-held Monitor’s
PULSE TEST capability must be enabled). The
block being Pulse Tested must be the active block.

1. From the Analyze menu, press F4 (Pulse Test).
The Pulse Test display appears:

PULSE TEST
REFS (cktreferences) O;
NO FAULTS

exec

For a PLC host, line 2 shows the block’s as-
signed references and its /O configuration.
Line 3 shows whether the block has any faults.

2. Press F1 (Execute) to pulse all outputs on the
block once. If the word FAULTS appears, it
means that one or more diagnostic errors have
occurred. Go to the Monitor/Control menu to
display the specific type of fault that has oc-
curred.

Clearing Pulse Test Faults

If you press the CLEAR key from the Pulse Test
screen, all faults on the block will be cleared.

If you press the Clear key from the
Monitor/Control screen (after displaying a specific
circuit fault), only that fault will be cleared.

Pulse Test Error Messages

If the Pulse Test cannot be performed or if the
block fails to respond, an error message appears.
Press the Clear key to remove the message.

E:PUL TST DISABLE

A Pulse Test cannot be performed unless the
block’s configuration is changed.

E:INVLD BLK TYPE

The block does not support Pulse Tests.

E:INVLD BLK CONFIG

The active block is an inputs-only block.

E:PULSE TEST FAIL

The HHM has not received an acknowledgement
from the block within the predetermined amount
of time. Retry the test. If it continues to fail, check
the serial bus cable and active block.
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Chapter |  Reading CPU Memory

6

This chapter explains how to use a Hand-held Monitor to read data in a specified memory location in a
Series 90-70, Series Six, or Series Five PLC. New data from the specified memory location is displayed
every three seconds.

General Instructions

1. Be sure the Hand-held Monitor is set up for the type of PLC host you want to read data from. (See
page 3-5 for instructions).

2. If the Hand-held Monitor is NOT attached directly to the PLC’s bus controller, or if another device is
designated as “active” when you enter the Device Memory function, use the F4 (SBA) key and enter
the bus controller’s Device Number (serial bus address).

3. Toread data from the selected bus controller, press F4 from the Main Menu and specify the memory
location to be read as instructed below.

GFK-0121E
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Series 90 PLC

For a Series 90-70 PLC, the Hand-held Monitor can
read data from %R, %AI %AQ,%I, %Q, %T, %M,
%S, %SA, %SB, %SC, and %G memory.

For a Series 90-70 PLC, the memory
location/content screen looks like this example:

DEVICE MEMORY 15
% R 1
tgl chng entr SBA

The top line shows the currently-selected Device
Number (15 in the example above). Line 2 shows
the memory type currently accessed, and a
reference location within that memory type. In
this example, the selected location is %R0001.

From this screen, use the HHM function keys to:
A. Select a different bus device (press F4 (SBA)).
B. Select another memory type (press F1 (tgl)).

C. Select another reference location (press
F2(chng), then enter the desired numerical
offset).

D. Display the current memory contents of the
specified location (press F3 (entr)).

6-2

When F3 (entr) is pressed, the HHM displays the
content in either bit or word format, as
appropriate for the selected memory type. For
example, here word data is displayed, because the
selected memory type (%R) is word-based:

DEVICE MEMORY 15

% R 1
WORD 139
> < loc

From this screen, you can display the current

contents of other locations in the selected memory

type:

A. Use the F1 (> ) key to increment the memory
offset (location).

B. Use the F2 ( <) key to decrement the memory
offset.

C. Use the F3 (loc) key if you want to enter an off-
set from the HHM keypad.

Hand-held Monitor User’s Guide — June 1994
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Series Six PLC

For a Series Six PLC, the Hand-held Monitor can
read data from register memory. That includes1/0
data mapped into register memory, (it is easier to
display I/0 data with the HHM’s Monitor Block or
Monitor Control Reference function).

For a Series Six PLC, the Device Memory screen
lookslike this example:

DEVICE MEMORY 7
MEM: (location)

tgl chng entr SBA

The top line shows the currently-selected Device
Number (7 in the example above). If there is a
currently-selected memory location, it appears on
the second line of the display as two numbers
separated by a colon.

The number on the left will be:
32768 for a Series Six PLC

The number on the right is the actual memory
location that will be read.

From this screen, use the Hand-held Monitor
function keys to:

A. Select a different device on the bus (press F4
(SBA)).

B. Select another memory type (press F2 (chng)).
See right for instructions.

C. Select another reference location in the dis-
played memory type (press F2(chng)). See
right for instructions.

D. Display the current memory contents of the
specified location (press F3 (entr)).

Chapter 6 Reading CPU Memory

Enter or Change the PLC Type
To enter or change the PLC type:

1. Press F3 (chng). A cursor appears at the left of
the colon. For a Series Six PLC, enter the num-
ber 32768.

2. Press the F3 (entr) key.

Enter or Change the Memory Location

To enter or change the memory location:

1. On the same screen, press F1 (>) to move the
cursor to the right of the colon.

2. Press F2 (chng).

3. Enter a number equal to the actual register
number plus 16383. For example, for regis-
ter#100, you would enter (16383 + 100), which
is 16483:

MEM: 32768¢:161483

Expanded /0 Data

Expanded I/0 data is mapped into registers and
can be accessed as described above. 1/0 data from
channel 0, or the main I/0 chain in an expanded
I/0 system can be displayed using the integer
result of the following formula:

((point number — 1) / 8) + table offset

The table offset is either 8192 for the output table
or 8320 for the input table. Example: to display
input 672, you would enter: ((672 - 1) / 8) +8320,
which is 8403.
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Series Five PLC

For a Series Five PLC, the Hand-held Monitor can
read data from register memory. That includes1/0
data mapped into register memory, (it is easier to
display I/0 data with the HHM’s Monitor Block or
Monitor Control Reference function).

For a Series Five PLC, the Device Memory screen
lookslike this example:

DEVICE MEMORY 7
MEM : (location)

tgl chng entr SBA

The top line shows the currently-selected Device
Number (7 in the example above). If there is a
currently-selected memory location, it appears on
the second line of the display as two numbers
separated by a colon.

The number on the left will be:
133  for a Series Five PLC

The number on the right is the actual memory
location that will be read.

From this screen, use the Hand-held Monitor
function keys to:

A. Select a different device on the bus (press F4
(SBA)).

B. Select another memory type (press F2 (chng)).
See right for instructions.

C. Select another reference location in the dis-
played memory type (press F2(chng)). See
right for instructions.

D. Display the current memory contents of the
specified location (press F3 (entr)).

64

Enter or Change the PLC Type

To enter or change the PLC type:

1. Press F3 (chng). A cursor appears at the left of
the colon. For a Series Six PLC, enter the num-
ber 32768.

2. Press the F3 (entr) key.

Enter or Change the Memory Location

To enter or change the memory location:

1. On the same screen, press F1 (>) to move the
cursor to the right of the colon.

2. Press F2 (chng).

3. Enter the byte offset of the data. This is equal
to (2 x register #) — 2. For example, for regis-
ter#100, you would enter (2 x 100) - 2, which
is 198.

/0 Data

Series Five I/0O data can be displayed using the
integer result of this formula:

(point number) / 8 + table offset
The table offsets for Series Fivel/O are:

channel 1 inputs 32768
channel 2 inputs 32896
channel 1 outputs 33024
channel 2 outputs 33152

Example: to display channel 2 output 12, you
would enter:12/8 + 33152, which is 33153:

MEM : 133:33153

Press F3 (ENTR) to save the memory location. To
display the memory content of this location, press
F3 (ENTR) again.
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Changing the Data Format

When the memory display first appears, it looks
like this example:

DEVICE MEMORY 7

MEM: 1:655214

WORD 12345
val addr

You can display either one byte or one word of
data. You can also select either decimal display:

WORD 12345
BYTE 3
or binary display:

4414411144444411
44444411

To change the data format:

1.
2.

GFK-0121E

Press F2 (VAL).

Use the function keys to select the format you
want.

Press the D MENU key to return to the pre-
vious screen, where the value will be displayed.

Chapter 6 Reading CPU Memory

Changingthe Selected Address

To change the address being monitored, press F3
(ADDR). The HHM shows:

DEVICE MEMORY 7
MEM: (location)

WORD (value)

> < loc

To Display Information from Another Device:
press F3 (Location). The function key assignments
change. Now press F4 (SBA). Select the new
Device Number then press F3 (ENTR).

To Increment or Decrement the Memory Address:
use the F1 (>) and F2 (<) keys.

To Enter a New Address: press F3 (LOC). Line
4displays new function key assignments. Key in
the memory location as explained previously.



Chapter |  Error Messages

/

This chapter explains error messages that may be displayed on the Hand-held Monitor.

Powerup Error Messages #2

If an error occurs during the Hand-held Monitor’s
self-test, this multi-language error display may
appear:

#4

PWRUP ERROR #1
ERREUR # 1
EIGTEST:FEHL#1
ERRORE INIZ #1

Cycle power to the Hand-held Monitor and try
again. If the message returns, look for its error
number in the list at right.

#5

The HHM has a faulty EPROM. Obtain a
replacement or an HHM upgrade kit.

The HHM may have been assigned a De-
vice Number already used on the bus. Press
the ON/OFF key, then disconnect the HHM
from the device it is attached to. Press the
ON/OFFkey again. Following the instruc-
tions on page 3-4, assign the HHM a differ-
ent Device Number.

At 38.4 Kbaud, unterminated HHM cable
may cause this message. Remove the HHM
cable or check that HHM is connected to a
properly-terminated bus.

This error may occur if the Hand-held Mon-
itor is connected to a bus and an incorrect
baud rate is selected.

This number indicates an internal fault, or
excessive noise on the bus, or that the bus is
operating at a different baud rate from the
HHM. Press the ON/OFF key then discon-
nect the HHM cable from the bus and from
the HHM. Press the ON/OFF key again. If
the message reappears, replace the HHM.
This error may occur if the Hand-held Mon-
itor is connected to a bus and an incorrect
baud rate is selected.

#1, 2, 3, or 6 indicates that the Hand-held Monitor
must be replaced.
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Operating Error Messages

The HHM may display one of the messages
shown below when the ON/OFF key is pressed or
during operation. If a message appears, press the
Clear key, then follow any action suggested.

E: NO ACTIVE ADDR

No active device has been selected, so many
functions do not operate. See page 5-2 to select an
active device.

E: KEY=MONTR ONLY

Place the keyswitch in Configure mode (the key
must be present). Press Clear, then retry the
operation. Press Enter.

E: FNCTN DISABLED

The function just selected is disabled by the
HHM'’s current configuration. Press the Clear key
to remove the message.

E: COMM ERROR

HHM cannot communicate with the device. If the
HHM is connected directly to a device which is not
on an operating bus, be sure a terminating resistor is
connected across Serial 1 and Serial 2. If the
message returns, check the bus controller and HHM
cable connections. Try other devices.

E: EEPROM FAILURE

If you are using the HHM to configure or force a
block, clear the message and go to Block/Bus
Status menu. Press the Clear key. If the block’s
Unit OK LED continues to blink, power down the
block and replace the Terminal Assembly,
configuring the replacement to match the original.

DIFFERENT BAUD

The HHM and block have been set for different
baud rates: one is set for 153.6Kbaud standard and
the other is set for 153.6 Kbaud extended (the
HHM will not communicate with the bus if any
baud rate conflict exists). All devices on the bus
must be set to the same baud rate.

Additional Messages: The following additional
messages may appear during normal system use:

E: FNCTN DISABLED

E: NO SUCH DEVICE

E: MONITOR ONLY

7-2 Hand-held Monitor User’s Guide — June 1994

Configuration Error Messages

The following messages may appear while
configuring a bus device. They usually indicate an
incorrect selection.

E: CONFIG PROTECT

The device’s configuration is protected, its features
cannot be changed. To configure the block, disable
Configuration Protection.

E: NOT ON BLOCK

To configure the Device Number, connect the
HHM directly to that device.

E: DUP BLOCK NO

The Device Number has already been assigned.
This message only appears if the device is
connected to a operating bus. Another number
must be assigned to one of the devices in conflict.

E: DUPL I/0O REFS

The PLC Reference Number conflicts with or
overlaps one already assigned to another device
on the bus. Assign a different reference to one of
the devices in conflict.

E: OUT OF RANGE

The Reference Number is too high.

E: NOT BYTE BNDRY

The Reference Number does not begin on a byte
boundary (1,9, 17.. ).

E: INVALD BLK CFG

The configuration entry is not valid.

E: NO SUCH DEVICE

The destination device does not exist. Check the
Device Number.

E: DIFF BLK TYPES

Copy Configuration cannot be used between
dissimilar device types.

E: COPY ERROR

An error has occurred during Copy Configuration.
Press Clear and try again.

E: FNCTN DISABLED

The function is not currently enabled for the
HHM.
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A

AC operation, 2-1
AC power required, 1-5, 2-1
Accessories, 1-3

Active device, selecting on HHM, 4-6 , 5-2
,9-4,5-8

Adapter
230VAC connector, 2-2
AC power, 2-1

Alarm diagnostic, 5-10

Analogblocks
Monitor block screen, 5-5
Monitor/Control Reference screens, 5-10

B

Battery pack, 1-3
charging, 2-1, 2-3
operation, 2-3
replacing, 2-3

Baud rate, 1-5
configuring for bus devices, 4-4
configuring HHM to change for blocks,

error, 7-2
selecting after powering up HHM, 3-2

Block ID, configuring HHM to change for
blocks, 3-5

Block/BusStatusdisplay
for Bus Controller, 5-3
for Genius block, Remote I/0 Scanner,
or Field Processor, 5-2

Bracket, mounting, 2-7

Bus
displaying number of devices on, 5-3
dual
switching, 5-3
viewing presently active bus, 5-4
scan time, display, 5-3
status, 5-3

Bus controllers
Block/BusStatusdisplay, 5-3
compatibility with HHM versions, 1-4

Bus Switching Module, compatibility with
HHM versions, 1-4

C

Case, 1-3
Catalog numbers
Genius blocks and HHM versions, 1-4
HHM, options, accessories, 1-5
Charger, 1-3
catalog number, 1-5
using, 2-1
COMM Error message, 3-7
Communications error, 7-2
Compatibility with other devices, 1-4

Configuration
for bus devices
copying, 4-6
Field Control modules, 4-8
Field Processor, 4-7
Genius blocks, 4-6
grounding required for offline config-
uration, 4-2
menus, 4-3
online or offline, 4-2
Program Block ID, 4-4
Remote I/0 Scanner, 4-5
for permanently installed HHM, 2-6
sequence for HHM, 3-4
setting up HHM to configure bus de-
vices, 3-6

Configuration Protected error, 4-3 , 7-2

Connector, external
catalog number, 1-5
installation instructions, 2-9

Copy error, 7-2
CPU, host, configuring HHM for, 3-5

Current, display for PowerTRAC block,
5-11

D

D connector, 2-8

Data type, changing when monitoring re-
mote drop, 5-15

Description, 1-2

Device number
HHM, 3-4
of bus device, changing, 4-4

Diagnostics
displaying, 5-9
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for analog, RTD, or Thermocouple
block, 5-10

Different Baud error, 7-2
Different Block Types error, 7-2
Dimensions, 1-5

Display, 1-5
special characters, 1-3
testing, 3-7

Duplicate Block Number error, 7-2

Duplicate I/0 References error, 7-2

E

EEPROM failure, 3-7
EEPROM Failure error, 7-2
Error messages, during HHM test, 3-7

F

Failed switch diagnostic, 5-9

Fault clearing

configuring HHM to enable fault clear-
ing, 3-6

from Block/Bus Status screen, 5-3

on analog, RTD, or Thermocouple
block, 5-10

on discrete, relay or High-speed Count-
er block, 5-9

on remote drop, 5-14, 5-16

Features, 1-1
Feedback Error diagnostic, 5-10

Field Control products, compatibility with
HHM versions, 1-4

Field Processor, configuration overview,
4-7

Forcingl/O

configuring HHM to perform, 3-6

on analog, RTD, or Thermocouple
block, 5-10

on Monitor/Control Reference screen,
5-9

on remote drop, 5-14, 5-15

viewing present status, 5-4

viewing present status of analog circuit,

viewing present status of circuit on RTD
or Thermocouple block, 5-5

Function Disabled error, 7-2

G

Genius blocks
compatibility with HHM versions, 1-4
I/Otype, 5-4
monitoring with HHM, 5-4

H

Hardware setup, 2-1

High-speed Counter blocks, Monitor
block screen, 5-6

High-speed Counter Block
Inputs, display, 5-6
presets, display, 5-6

Humidity, 1-5

1/0 forced status, 5-4

[/0 scanning, for Field Processor, disable,
4-8

I/0type, 5-4
Input Shorted diagnostic, 5-10
Installation, instructions, 2-6 , 2-7

Installed HHM, configuration sugges-
tions, 2-6

Internal Fault diagnostic, 5-10

Invalid Block Configuration error, 7-2

K

Key=Monitor error, 7-2

Keypad, 1-1, 1-2
testing operation, 3-7

Keys, 1-3, 1-5

Keyswitch, 1-1
positions, 1-3

L

Languages, 1-1,1-5, 3-5
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LCDdisplay, 1-1
Loss of I/0 Power diagnostic, 5-9

Low power, 2-3

M

Memory, reading, 6-1
Menus, main, 3-3

Monitor Block screens, 5-4
Monitor Only error, 7-2

Monitor/Control Reference screens
for Field Processor, 5-15
for Genius blocks, 5-8
for Remote I/0 Scanner, 5-13

Monitoring, menus, 5-1

Mounting bracket, 2-7

N

No Active Address error, 7-2
No Faults diagnostic, 5-12
No Load diagnostic, 5-9

No Such Device error, 7-2
Not Byte Boundary error, 7-2

Not on Block error, 7-2

o)

Open Wire diagnostic, 5-9 , 5-10
Operating time, 1-5

Out of Range error, 7-2
Overload diagnostic, 5-9
Overrange diagnostic, 5-10

Overtemperature diagnostic, 5-9 , 5-10

P

PCIM/QBIM, selecting as host, 3-5
Power, display for PowerTRAC block, 5-11

Power sources, 2-1

PowerTRAC block
data sequence, 5-11
display data, 5-7
Monitor/Control Reference screens, 5-11

Powerup, 3-2

Powerup Error messages, 7-1
Program Block ID screens, 4-4
PROM, changing, 2-4

Pulse Testing outputs, 5-17

R

Redundant bus, 5-4
switching, 5-3

References
asterisks appear on screen, 5-2
not on byte bundary, 7-2
of Genius block, displaying, 5-4

Relay blocks, monitor block screen, 5-5
Remote drop, configuration, 4-5

Remote I/0 Scanner
compatibility with HHM versions, 1-4
configuring I/O map, 4-4, 4-5

RTD blocks
Monitor block screen, 5-5
Monitor/Control Reference screens, 5-10

S

Serial bus address
configuring for HHM, 3-4
error caused by duplicating, 7-2
of bus device, changing, 4-4

Series 90 PLC
reading memory, 6-2
references displayed, 5-2
selecting as host type, 3-5

Series Five PLC
reading memory, 6-4
references displayed, 5-2
selecting as host type, 3-5

Series Six PLC
reading memory, 6-3
references displayed, 5-2
selecting as host type, 3-5
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Short Circuit diagnostic, 5-9

Shutoff
automatic, 2-3
configuring for HHM, 3-5

Specifications, 1-5

T

Temperature specifications, 1-5
Testing, 3-7

Thermocouple blocks
Monitor block screen, 5-5
Monitor/Control Reference screens, 5-10

U

Underrange diagnostic, 5-10
Upgrading the HHM, 2-4

\'

VARs, display for PowerTRAC block, 5-11

Voltage, display for PowerTRAC block,
5-11

W

Watt-hours, display for PowerTRAC block,
5-11

Wiring FError diagnostic, 5-10
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